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Введение 

 

 Системы машинного зрения в современном мире находят повсеместное 

применение, что связано в первую очередь с развитием технологий и повыше-

нием доступной высокопроизводительной вычислительной техники, а также 

усовершенствованием устройств получения цифровой фото и видеоинформации. 

На сегодняшний день не существует идеальных алгоритмов и в целом систем 

машинного зрения, которые предназначены для решения универсальных задач. 

Зачастую в каждом конкретном случае разрабатывается проект, подходящий для 

решения поставленной задачи с использованием как известных методов и алго-

ритмов, так и разработанных новых. 

 Высокий уровень автоматизации различных сфер человеческой деятельно-

сти требует от компьютерных систем не только быстро и точно выполнять, но 

также эффективно распознавать визуальную информацию и на основе её анализа 

решать сложные задачи управления и контроля. В общем виде системы машин-

ного зрения представляют собой взаимосвязанную технологическую последова-

тельность, включающую следующие звенья (рисунок 1): 

- получение изображения от видеокамеры; 

- обработка (оцифровка) изображения; 

- анализ цифрового изображения и выделение нужной информации; 

- перемещение камеры или изображения в пространстве. 

При этом видеокамера, программные средства и устройства обработки 

изображений являются главными составляющими системы машинного зрения, 

объединяясь в термин «техническое зрение». 

 

 
 

Рисунок 1 – Элементы технологии машинного зрения 
 

 Данное учебно-методическое пособие предназначено для выполнения ла-

бораторных работ по дисциплине «Цифровая обработка сигналов и изображе-

ний» в рамках раздела «Цифровая обработка изображений». Главной задачей при 

этом является ознакомление студентов с технологиями, применяемыми при по-

строении систем технического зрения. Лабораторные работы выполняются на 
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лабораторном стенде компании National Instruments, предназначенном для изу-

чения основ систем технического зрения. Основой стенда является интеллекту-

альная камера NI Smart Camera, которая дает возможность студентам в интерак-

тивном режиме осуществлять сбор видеоизображений и их обработку. 

 Перечень элементов лабораторного комплекса «Лаборатория технического 

зрения» (рисунок 2): 

- интеллектуальная камера NI Smart Camera; 

- набор элементов для анализа; 

- программное обеспечение для сбора и обработки изображений; 

- персональный компьютер. 

 

  
а б 

 
 

в г 

 

а – интеллектуальная камера; б – набор элементов для анализа;  

в – программное обеспечение; г – персональный компьютер 

 

Рисунок 2 – Лабораторный комплекс «Лаборатория технического зрения» 
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1 Проблематика машинного зрения 
 

Цифровая обработка и анализ изображений находят все большее примене-

ние в различных областях науки и техники, таких как интеллектуальные робото-

технические комплексы, системы промышленного контроля, системы управле-

ния движущимися аппаратами, обработка данных дистанционного зондирова-

ния, биомедицинские исследования, новые технологии обработки документов и 

множество других.  

 Машинное зрение следует рассматривать как комплексную, технологиче-

скую область научных и инженерных знаний, охватывающую все проблемы раз-

работки практических систем. 

 Наряду с терминами «машинное зрение» (machine vision) и «техническое 

зрение» (technical vision) в литературе часто употребляются такие понятия, как 

«компьютерное зрение» (computer vision), «обработка изображений» (image pro-

cessing), «понимание изображений» (image understanding).  

 Термин «компьютерное зрение» обозначает научную дисциплину, изуча-

ющую теорию и базовые алгоритмы анализа изображений и сцен. 

 Понятие «обработка изображений» часто употребляется как указатель ис-

ключительно на предметную, а не научную область. Иногда под этим понимают 

обработку нижнего уровня, когда результатом обработки снова является изобра-

жение. 

 Термин «понимание изображений» употребляется для обозначения обра-

ботки верхнего уровня, часто в контексте применения методов искусственного 

интеллекта и машинного обучения. 

 Машинное зрение тесно связано с целым рядом смежных дисциплин: ком-

пьютерное зрение, искусственный интеллект, а также распознавание образов 

(pattern recognition) и цифровая фотограмметрия (digital photogrammetry).  

 Можно выделить три типа основных требований к алгоритмам машинного 

обучения: 

- робастность – устойчивость алгоритмов к значительным искажениям и 

меняющимся факторам (помехи и «шум», сложный текстурированный фон, ис-

кажающие оптические эффекты, несинхронная регистрация и обработка данных 

и др.); 

- точность – на примере обнаружения объектов это означает, что необхо-

димо не просто выделить объект, но и точно указать в системе координат изоб-

ражения его положение и размеры в каком-либо смысле; 

- вычислительная реализуемость, так как, несмотря на существенное раз-

витие вычислительной техники, особенно в промышленных приложениях реаль-

ного времени, характеристики вычислительной техники и их свойства далеки от 

желаемых и реализация процедуры поиска объекта связана с угрозой лавинооб-

разного роста числа вычислений. 

До сих пор не существует единого математического аппарата и единой об-

щепринятой методики разработки алгоритмов в области машинного зрения. При 
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решении реальных задач обработки изображений, как правило, недостаточно од-

ного метода. Требуется последовательное, а нередко итерационное применение не-

скольких методов. Тогда возникает проблема выбора этих методов и их конкретных 

параметров. Разработка систем анализа и обработки цифровых изображений вклю-

чает в себя следующие этапы:  

- предварительное исследование свойств типовых изображений; 

- анализ применимости известных методов обработки изображений в данной 

конкретной задаче; 

- разработка новых алгоритмов; 

- первичная программная реализация новых алгоритмов и проверка их эф-

фективности; 

- окончательная программная реализация алгоритмов. 

 Многие разработчики рано или поздно сталкиваются с выбором: разрабаты-

вать что-то самому или использовать готовые коды (библиотеки).  

 Некоторые плюсы использования готовых кодов: 

- быстрая разработка проекта; 

- код протестирован многими пользователями; 

- программист концентрируется на основной задаче, а не на вспомогатель-

ных; 

- не требует затраты большого количества человеко-часов, в отличие от раз-

работки собственной библиотеки. 

Некоторые минусы использования готовых кодов: 

- стоимость лицензии может превысить стоимость разработки; 

- сложная общая архитектура, тяжело разобраться в возникающих ошибках; 

- одна библиотека может не содержать все необходимые для проекта функ-

ции; 

- задача не решается оптимальным способом при использовании только гото-

вых библиотек. 

 В использовании собственной разработки тоже есть свои плюсы: 

- члены команды знают, как работают программы; 

- максимально производительное решение; 

- возможность развития библиотеки в нужном вам направлении. 

 Минусы разработки собственной библиотеки: 

- требуется высококвалифицированный разработчик; 

- длительная разработка и тестирование; 

- содержит значительное число ошибок, особенно на стадии внедрения. 

 Для начинающих использование и анализ готовых решений позволяют быст-

рее повышать квалификацию и создавать несложные проекты. Среди существую-

щих средств подобного рода необходимо выделить пакет прикладных программ 

для решения технических вычислений Matlab, открытую библиотеку компьютер-

ного зрения OpenCV, программные средства фирмы National Instruments – среда ви-

зуального программирования LabVIEW – и настраиваемое программное обеспече-

ние для систем машинного зрения Vision Builder for Automated Inspection.  
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 В настоящем учебно-методическом пособии все излагаемые теоретические 

положения и методы машинного зрения приведены в контексте реализации си-

стем технического зрения на базе программно-аппаратных средств фирмы Na-

tional Instruments.  
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2 Описание лабораторного комплекса от NI 
 

2.1 Описание аппаратной платформы 

Основой лабораторного комплекса от NI является интеллектуальная ка-

мера NI 1742, которая объединяет датчик изображения, процессор и цифровой 

ввод-вывод в прочном компактном корпусе. В таблице 1 представлены свойства 

NI 1742.  

 

Таблица 1 – Интеллектуальная камера NI 1742 

Модель Процессор Датчик 

Контроллер непосред-

ственного управления 

источником света 

Интерфейс 

квадратурного 

энкодера 

NI 1742 533 МГц 

1/3 дюйма ПЗС, моно-

хромный 640 × 480 

пикселей (VGA) 

Да Да 

 

В интеллектуальной камере NI 1742 имеется разъем RS-232 и два разъема 

Ethernet 1000, используются стандартные C-оправы объектива, предусмотрена 

поддержка контроллера, непосредственно управляющего источником света и 

квадратурного энкодера. Интегрированный в камеру контроллер непосредствен-

ного управления источником света напрямую питает регулируемые током разно-

образные источники света.  

В NI 1742 имеются также пять светодиодных индикаторов для информи-

рования о состоянии системы, четыре DIP-переключателя для настройки опций 

начальной загрузки, по два изолированных входа и выхода для подключения 

внешних устройств. Кроме того, есть выходы стробирования для управления све-

том – один 5 V ТТЛ и один 24 V (рисунок 3).  

 

VGA-датчик 

В камерах NI 1742 используется монохромная ПЗС-матрица Sony 

ICX424AL с форматом оптики 1/3 дюйма, 640 × 480 пикселей. Пиксель равен 

7,4 × 7,4 мкм. Размеры светочувствительной части датчика составляют 4,736 мм 

в горизонтальном направлении и 3,552 мм в вертикальном направлении.  

 

Поле зрения 

Для расчета горизонтального и вертикального полей зрения (FOV), необ-

ходимых для оптической системы ввода изображений, применяют формулу (1).  

 

FOV = SD·WD/FL,     (1) 

 

где FOV – поле зрения; SD – размер датчика; WD – рабочее расстояние; FL – 

фокусное расстояние линз.  
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1 – датчик изображения; 2 – стандартная С-оправа объектива; 

3 – разъем для источника света; 4 – светодиоды; 5 – DIP-переключатели; 

6 – разъем питания POWER-I/O; 7 – разъем Ethernet 

 

Рисунок 3 – Интеллектуальная камера NI 1742 

 

На рисунке 4 показаны поле зрения по горизонтали и рабочее расстояние.  
 

 
 

1 – датчик изображения; 2 – рабочее расстояние;  

3 – поле зрения по горизонтали 

 

Рисунок 4 – Параметры оптической системы 

 

Поле зрения – это область, доступная интеллектуальной камере для обсле-

дования. Горизонтальные и вертикальные размеры области обследования опре-

деляют поле зрения. При работе необходимо убедиться, что объект исследования 

располагается в поле зрения. Например, если рабочее расстояние составляет    
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100 мм, а фокусное расстояние линзы – 8 мм, тогда поле зрения в горизонтальном 

направлении равно 

 

FOVгоризонт = 4,736·100/8 = 59,2 мм. 

 

Аналогично вычисляется поле зрения в вертикальном направлении: 

 

FOVверт = 3,552·100/8 = 44,4 мм. 

 

При настройке системы необходимо изменять различные параметры из 

формулы (1) до тех пор, пока не будет найдена комбинация, удовлетворяющая 

требованиям исследования.  

 

Пояснение индикации светодиодов 

На рисунке 5 показано расположение светодиодов NI 1742.  

 

 
 

Рисунок 5 – Светодиоды NI 1742 

 

Светодиод POWER (Питание). Указывает, достаточное ли питание пода-

ется на камеру. При правильном питании камеры горит зеленым светом. Если 

питание к камере не подключено, не горит. При первой подаче питания на 

NI 1742 мигает красным светом в течение одной секунды, пока внутренние 

устройства входят в рабочий режим. Если светодиод POWER горит красным све-

том дольше одной секунды, это указывает на то, что напряжение питания выхо-

дит за пределы допустимого.  

Светодиод STATUS (Статус). Горит зеленым светом при нормальном 

функционировании камеры. Интеллектуальная камера указывает на наличие осо-

бых состояний миганием светодиода STATUS (таблица 2).  
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Таблица 2 – Индикация светодиода STATUS  
Режим 

светодиода 

Цвет 

светодиода 
Индикация 

1 2 3 

Непрерывный  Зеленый  
Инициализация прошла успешно и камера готова к ис-

пользованию  

Одна вспышка  Зеленый  

IP-адрес или программное обеспечение интеллектуаль-

ной камеры не настроены. От производителя камера по-

ставляется в несконфигурированном состоянии. Интел-

лектуальная камера переходит в несконфигурированное 

состояние, если она настроена на DHCP, а доступного 

сервера DHCP нет. Используйте MAX или Vision 

Builder AI для конфигурирования камеры. Обратитесь к 

руководству Getting Started with the NI 17xx Smart 

Camera за информацией о конфигурировании интеллек-

туальной камеры  

Две вспышки  Зеленый  

Интеллектуальная камера обнаружила ошибку в 

настройках программного обеспечения. Камера автома-

тически загружается в безопасном режиме, несмотря на 

положение DIP-переключателя SAFE MODE. Обычно 

это случается, когда прерывается попытка обновления 

программного обеспечения или если с интеллектуаль-

ной камеры были удалены системные файлы. Переуста-

новите программное обеспечение интеллектуальной ка-

меры. Обратитесь к руководству Getting Started with the 

NI 17xx Smart Camera для получения информации об 

установке программного обеспечения интеллектуаль-

ной камеры 

Три вспышки  Зеленый  

Интеллектуальная камера находится в безопасном ре-

жиме, поскольку DIP-переключатель SAFE MODE уста-

новлен в положение «Вкл». Обратитесь к разделу «Кон-

фигурирование DIP-переключателей» для получения 

информации о DIP-переключателе SAFE MODE 

Четыре вспышки  Зеленый  

Интеллектуальная камера зафиксировала два следую-

щих друг за другом программных исключения. При 

этом камера автоматически перезагружается. После по-

вторения ситуации камера остается в состоянии исклю-

чения, сигнализируя о необходимости решить про-

блему. Переустановите программное обеспечение. Об-

ратитесь к руководству Getting Started with the NI 17xx 

Smart Camera для получения информации об установке 

программного обеспечения интеллектуальной камеры  
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1 2 3 

Пять вспышек  Зеленый  

Интеллектуальная камера зафиксировала критическую 

ошибку. Переустановите программное обеспечение или 

свяжитесь с National Instruments для получения под-

держки. Обратитесь к руководству Getting Started with 

the NI 17xx Smart Camera для получения информации об 

установке программного обеспечения интеллектуаль-

ной камеры 

Мигание  Красный  

Интеллектуальная камера обнаружила сбой или зависа-

ние программного обеспечения. Свяжитесь с National 

Instruments для получения поддержки 

Непрерывный  Красный  

Интеллектуальная камера зафиксировала критическую 

ошибку загрузочного ПЗУ. Свяжитесь с National 

Instruments для получения поддержки 

 

Светодиод IMG ACQ (Захват изображения). Кратковременно загорается 

зеленым светом, когда изображение захвачено и готово для анализа. При высо-

кой частоте кадров свечение светодиода кажется постоянным. Если оба светоди-

ода – IMG ACQ и FAIL – мигают красным, это указывает на то, что камера NI 

1742 отключена из-за превышения в ней максимально допустимой температуры. 

Светодиод PASS. Это зеленый светодиод, настраиваемый пользователем 

через узел свойств IMAQ в LabVIEW или на шаге Smart Camera I/O (ввод-вывод 

интеллектуальной камеры) в Vision Builder AI.  

Светодиод FAIL. Это красный светодиод, также настраиваемый пользова-

телем через узел свойств IMAQ в LabVIEW или на шаге Smart Camera I/O (ввод-

вывод интеллектуальной камеры) в Vision Builder AI.  

 

Порты Ethernet 

На рисунке 6 показано размещение Ethernet-разъемов NI 1742. 

 

 
 

1 – разъем 1; 2 – разъем 2 

 

Рисунок 6 – Ethernet-разъемы NI 1742  
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Разъем 1 является основным, а разъем 2 – дополнительным. Основной 

разъем может быть настроен на получение IP-адреса через DHCP-сервер. Допол-

нительный разъем может быть настроен только на получение статического IP-

адреса. Оба порта Ethernet NI 1742 могут быть подключены к 10, 100 или 1000 

Мбит/с (1 Гбит/с) Ethernet-сети в режиме полного дуплекса или полудуплекса. 

Камера NI 1742 автоматически определяет скоростные возможности и режим об-

мена (полный или полудуплекс) связываемых с камерой устройств и настраива-

ется на более быстрый общий интерфейс, может автоматически выполнять пере-

крестные подключения (auto-crossover), что позволяет использовать прямой или 

перекрестный Ethernet-кабель независимо от настройки связи. При использова-

нии экранированных Ethernet-кабелей для обеспечения полной помехозащищен-

ности сигналов убедитесь, что защитные оболочки Ethernet-кабелей и POWER-

I/O-кабель не соединены между собой. 

 

2.1  Используемое программное обеспечение 

Для разработки приложений на базе NI 17xx требуется один из програм- 

мных компонентов, указанных на рисунке 7. Процессы установки и настройки 

каждой среды разработки различны.  

 

 
 

Рисунок 7 – Варианты используемого программного обеспечения 

 

2.2.1  Программное обеспечение NI Vision Builder for Automated            

Inspection  

Vision Builder for Automated Inspection (Vision Builder AI) – настраиваемое 

программное обеспечение для систем машинного зрения, которое можно исполь-

зовать для конфигурирования NI 17xx, прототипирования, тестирования и за-

пуска приложений машинного зрения.  

Создание приложений в Vision Builder AI не требует написания программ. 

Vision Builder AI позволяет конфигурировать и тестировать последовательность 

шагов контроля изображений, а также запускать системы для автоматического 

контроля изображений. С Vision Builder AI можно решать сложные задачи кон-

троля изображений и принимать решения, основываясь на результатах выполне-

ния отдельных задач. Также есть возможность экспортировать сконфигуриро-

ванные задачи в LabVIEW для расширения возможностей приложения.  
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Документация по Vision Builder AI: 

- NI Vision Builder for Automated Inspection: Tutorial – учебник по конструк-

тору NI Vision Builder предоставляет пошаговые инструкции для автоматизиро-

ванного решения общих задач машинного зрения (например, контроля, измере-

ния, идентификации деталей, управления и подсчета).   

- NI Vision Builder for Automated Inspection: Configuration Help – содержит 

информацию об использовании конструктора NI Vision Builder для конфигури-

рования интерфейса систем автоматического контроля в приложениях машин-

ного зрения.   

- NI Vision Builder for Automated Inspection: Inspection Help – содержит ин-

формацию о приложениях, разработанных с помощью Vision Builder for Auto-

mated Inspection (Vision Builder AI) в Vision Builder AI Interface. 

 

2.2.2 Программное обеспечение LabVIEW  

LabVIEW – это графическая среда проектирования для разработки гибких 

и масштабируемых приложений. Для создания приложений машинного зрения с 

NI 17xx и LabVIEW необходимы следующие дополнительные модули: LabVIEW 

Real-Time Module, Vision Development Module и Vision Acquisition Software.  

LabVIEW Real-Time Module 

Модуль LabVIEW Real-Time (RT) объединяет возможности графической 

среды проектирования LabVIEW с производительностью оборудования реаль-

ного времени, позволяя создавать детерминированные системы реального вре-

мени и разрабатывая приложение в LabVIEW, в дальнейшем загружать его на 

целевую систему реального времени, например на интеллектуальную камеру NI 

17xx. Целевая система RT выполняет программу, не используя интерфейс поль-

зователя, и поэтому представляет собой надежную платформу для приложений 

реального времени.  

NI Vision Development Module 

NI Vision Development Module обеспечивает ввод и обработку изображе-

ний, а для анализа использует библиотеку, содержащую сотни функций для ре-

шения следующих типовых задач машинного зрения: сравнение с образцом, ана-

лиз по точкам, калибровка, измерения (вычисление расстояний), отображение 

черно-белых, цветных и бинарных изображений и др. 

С модулем NI Vision Development можно вводить, отображать и сохранять 

изображения, а также проводить их обработку и анализ. Используя NI Vision 

Development Module, новички и эксперты в области работы с изображениями мо-

гут разрабатывать простые и сложные приложения, зная логику работы модулей 

верхнего уровня, не вникая в особенности реализации алгоритмов.   

NI Vision Acquisition Software 

Компакт-диск NI Vision Acquisition Software содержит программу для кон-

фигурирования средств измерения и автоматизации Measurement & Automation 

Explorer (MAX), а также драйвер NI-IMAQ.  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Для настройки NI 17xx используется MAX. Есть возможность установить 

IP-адрес, обновить программное обеспечение на интеллектуальной камере, 

настроить режим запуска и задать характеристики освещения. Для получения ин-

формации о MAX можно обратиться к справочной информации Measurement 

&Automation Explorer Help for NI-IMAQ.  

Драйвер NI-IMAQ – это интерфейс между прикладным программным обес-

печением и NI 17xx, управляющий вводом-выводом изображений с интеллекту-

альной камеры NI 17xx и включающий обширную библиотеку виртуальных при-

боров, запускаемых из LabVIEW. В состав библиотеки входят программы кон-

фигурирования видеооборудования, а также управления запуском. Драйвер NI-

IMAQ выполняет все функции (высокого и низкого уровня), необходимые для 

получения и сохранения изображений, но не предоставляет возможности для их 

анализа. Примером функции высокого уровня может служить операция получе-

ния изображений в однократном или непрерывном режиме. Операции, которые 

требуют продвинутых знаний устройства NI 17xx и процесса ввода изображений, 

например настройка последовательности изображений, являются примером 

функций низкого уровня.  

Документация по LabVIEW и модулю NI Vision Development: 

- LabVIEW Help – содержит информацию о среде программирования 

LabVIEW, пошаговые инструкции по использованию LabVIEW, сведения о вир-

туальных приборах LabVIEW, функциях, палитрах, меню и инструментах.   

- Getting Started with LabVIEW – можно использовать данное руководство 

в качестве учебного пособия при знакомстве со средой графического програм-

мирования LabVIEW, а также при изучении базовых функциональных возмож-

ностей LabVIEW для создания приложений сбора данных и управления.   

- Getting Started with the LabVIEW Real-Time Module – можно использовать 

данное руководство в качестве учебного пособия при знакомстве с модулем 

LabVIEW Real-Time, а также при изучении основных функциональных возмож-

ностей Real-Time Module для создания приложений реального времени.   

- NI Vision Concepts Manual – содержит основные понятия анализа и обра-

ботки изображений, систем машинного зрения. Подробно обсуждаются функции 

для работы с изображениями.   

- NI Vision for LabVIEW Help – описывает, как создавать приложения ма-

шинного зрения и обработки изображений в LabVIEW, используя Vision 

Development Module. Справочный документ будет вашим проводником при ре-

шении задач, начиная с настройки системы обработки изображений и заканчивая 

измерениями. В документе также дается информация о том, как создавать при-

ложения реального времени, используя NI Vision и LabVIEW Real-Time Module, 

содержатся сведения о палитрах и виртуальных приборах (VIs) NI Vision в 

LabVIEW.  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Документация по NI Vision Acquisition Software: 

- NI-IMAQ VI Reference Help – содержит информацию о виртуальных при-

борах и свойствах для работы с драйвером NI-IMAQ.   

- Measurement & Automation Explorer Help for NI-IMAQ – описывает схему 

настройки драйвера NI-IMAQ, NI фрейм-граббера и интеллектуальных камер NI 

с помощью Measurement & Automation Explorer.   
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3 Цифровые изображения. Некоторые методы обработки и анализа 

изображений 

 

3.1  Основные шаги построения приложения системы технического 

зрения NI 

Несмотря на тот факт, что каждая система технического зрения (СТЗ) слу-

жит для решения конкретного перечня задач, можно выделить общие принципы 

их построения. Для NI Vision характерна следующая структурная схема компо-

новки основных блоков и модулей, входящих в состав системы (рисунок 8). 
 

 
 

Рисунок 8 – Общие шаги проектирования приложения 

для обработки изображений в системе NI 

 

Шаги, отмеченные штриховой линией, являются опциональными и приме-

няются пользователем по необходимости. 

  

Установка и настройка системы отображения 

Калибровка системы отображения 

Определение формата изображения 

Извлечение или чтение изображения 

Отображение изображения 

Сопоставление калибровочной информации 

Анализ изображения 

Улучшение изображения 

Выполнение измерений или идентификации 

объектов на изображении с помощью: 

1) полутоновых или цветных мер; 

2) анализа отдельных частей изображения; 

3) методов машинного зрения 

Получение и подго-

товка изображений 

для дальнейшей 

оценки и измерений 
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После установки системы, возможно, будет необходимо выполнить ее ка-

либровку, чтобы задать систему координат, а также компенсировать ошибки пер-

спективы и нелинейные ошибки, присущие системе. Ошибки перспективы воз-

никают в случае отсутствия перпендикулярности оси камеры и плоскости иссле-

дуемого объекта. Нелинейные ошибки могут быть обусловлены аберрацией оп-

тической составляющей системы. Перечисленные ошибки не приводят, как пра-

вило, к уничтожению обрабатываемой информации, однако могут стать причи-

ной ее частичного искажения, что является нежелательным эффектом в работе 

СТЗ. 

После создания ссылки на источник получения изображения система го-

това получать информацию для отображения в системе NI. Для реализации дан-

ной операции можно выбрать один из трех способов: 

- захват изображения через внешнее устройство – фото- или видеокамеру; 

- загрузка изображения из файла; 

- загрузка 2D-матрицы и ее последующее преобразование в изображение. 
 

3.2  Определение цифрового изображения, основные свойства 

Изображение является двухмерным массивом значений, определяющих 

интенсивность света. В данном учебно-методическом пособии термин «изобра-

жение» применяется к цифровому изображению, то есть это функция интенсив-

ности света: 

f(x, y), 
 

где f – яркость точки (x, y); x и y – пространственные координаты элемента изоб-

ражения, то есть пикселя. 

По умолчанию пиксель с координатами (0, 0) находится в левом верхнем 

углу изображения (рисунок 9). Обратите внимание, что координата х увеличива-

ется слева направо, а координата у – сверху вниз. 

 
Рисунок 9 – Координаты пикселей изображения 

 

При цифровой обработке изображения сенсор преобразует изображение в 

группу отдельных пикселей. Он присваивает каждому пикселю цифровые коор-

динаты, а также уровень яркости или код цвета, которые определяют яркость или 

цвет пикселя. 

Оцифрованное изображение обладает тремя основными свойствами: раз-

решением, резкостью и количеством каналов. Разрешение изображения опреде-

ляется числом строк и столбцов пикселей. Изображение, состоящее из m строк и 

Би
бл
ио
те
ка

 БГ
УИ
Р



19 
 

n столбцов, обладает разрешением m × n. У такого изображения m пикселей по 

горизонтальной оси и n – по вертикальной.  

Резкость изображения определяет количество различимых оттенков на 

картинке. Глубина цвета – это количество битов, использованных для кодирова-

ния цвета пикселя. Для заданной глубины цвета n резкость изображения равна 

2n, то есть пиксель может иметь 2n различных цветов. Например, если n равно 8 

битам, то пиксель может принимать 256 разных цветов: от 0 до 255. Если n равно 

16 битам, пиксель может принимать 65 536 различных значений – от 0 до 65 535 

или от минус 32 768 до 32 767. 

NI Vision поддерживает изображения в 8-, 10-, 12-, 14-, 16-битной кодиров-

ках, кодировку с плавающей точкой и цветную кодировку. Метод кодирования 

зависит от характеристик устройства захвата изображения, выбранного способа 

обработки и типа выполняемого анализа. Например, 8-битного кодирования до-

статочно для получения информации о форме объектов на изображении. Однако 

для точного измерения интенсивности света всего изображения или его части 

следует использовать 16-битную кодировку или кодировку с плавающей точкой. 

Если работа систем машинного зрения или приложений для цифровой об-

работки изображений зависит от цветового содержания осматриваемых или ана-

лизируемых объектов, нужно использовать цветную кодировку. NI Vision непо-

средственно не поддерживает иные кодировки, в частности 1-, 2- или 4-битные. 

Такие изображения при открытии автоматически преобразовываются в 8-битные 

(минимальная глубина цвета в NI Vision). 

С помощью инструментов NI можно вычленить такие первичные пара-

метры – составляющие цветного изображения, как компоненты цветовых моде-

лей RGB (Red, Green, and Blue), HSI (Hue, Saturation, and Intensity), HSL (Hue, 

Saturation, and Luminance) или HSV (Hue, Saturation, and Value). На рисунках 10 

и 11 представлены схемы разбиения изображений на первичные компоненты с 

возможностью преобразования и замены цветовой модели. 

 

 
Рисунок 10 – Первичные компоненты 32-битного изображения 
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Рисунок 11 – Первичные компоненты 64-битного изображения 

 

Количество каналов в изображении определяет количество массивов пик-

селей, образующих изображение. Черно-белое или псевдоцветное изображение 

содержит один канал. Изображение TrueColor состоит из трех каналов: красный, 

зеленый, синий. В таких изображениях оттенок пикселя кодируется тремя раз-

личными значениями. Цветное изображение – это комбинация трех массивов 

пикселей – красной, синей и зеленой составляющей в RGB-изображении. HSL-

изображения определяются значениями оттенка, насыщенности и яркости. 

«32-битный цвет» – это пример неправильного употребления термина при 

описании глубины цвета. Заблуждением является то, что 32-битный цвет позво-

ляет представить 2³² = 4 294 967 296 различных оттенков. В реальности 32-бит-

ный цвет является 24-битным (Truecolor) с дополнительным 8-битным каналом, 

который либо заполнен нулями (не влияет на цвет), либо представляет собой 

альфа-канал, который задает прозрачность изображения для каждого пикселя. То 

есть существует 16 777 216 оттенков цветов и 256 градаций прозрачности. 

Причиной, по которой используют «пустой» канал, является стремление 

оптимизировать работу с видеопамятью, которая у большинства современных 

компьютеров имеет 32-битную адресацию и 32-битную шину данных. 

Также 32-битным является представление цвета в системе CMYK (по 8 бит 

отводится на голубой, пурпурный, желтый и черный цвета). 

Соответственно, в обработке цифровых изображений под 64-битным фор-

матом обычно подразумевают 48-битные цветные изображения (Deep Color), до-

полненные 16-битным альфа-каналом. 

В компьютерной графике альфа-композиция (англ. аlpha compositing) обо-

значает процесс комбинирования изображения с фоном с целью создания эф-

фекта частичной прозрачности. Этот метод часто применяется для многопроход-

ной обработки изображения по частям с последующей комбинацией этих частей 

в единое двухмерное результирующее изображение. Таким образом, альфа-канал 

представляет собой пустое пространство, или просто прозрачность. 

Итак, средства NI позволяют выполнить разложение 32-битного изображе-

ния на индивидуальные компоненты, которые в дальнейшем могут быть преоб-

разованы в другую цветовую модель.  
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Палитры 

В то время как черно-белое изображение показывается на экране, NI Vision 

преобразовывает цвет каждого пикселя в интенсивность красного, синего и зеле-

ного цветов для соответствующего пикселя на экране. При этом используется 

цветовая таблица, палитра, где цвет соотносится с возможным черно-белым цве-

том на изображении. NI Vision предоставляет возможность настроить палитру, 

используемую для отображения 8-битного черно-белого изображения. 

Используя палитры можно воспроизводить различные образы на изобра-

жении, не изменяя исходные данные. Палитры могут создавать такие эффекты, 

как негатив или цветная маркировка. В последнем случае палитры удобны при 

детализации конкретных составляющих изображения, где общее число цветов 

ограничено. 

Отображение в различных палитрах помогает подчеркнуть области с осо-

бой интенсивностью, определить плавные или резкие черно-белые переходы, 

также передать детали, которые трудно воспринимаются на черно-белом изобра-

жении. Например, человеческий глаз более чувствителен к небольшим измене-

ниям интенсивности на светлой области, чем на темной. Использование цветной 

палитры может помочь различить эти небольшие изменения. 

Палитра – это массив RGB-цветов, предопределенный или определенный 

пользователем. Он определяет для каждого возможного черно-белого цвета соответ-

ствующий цвет, устанавливаемый пикселю. Черно-белый цвет пикселя выступает 

адресом в таблице, указывающим на соответствующие значения интенсивности 

красного, зеленого и синего цветов (RGB). Этот набор RGB-цветов определяет па-

литру, в которой различные количества красного, зеленого и синего цветов смеши-

ваются для получения цветового представления диапазона значений.  

В 8-битном черно-белом изображении пиксели могут иметь 28 или 256 цветов 

(от 0 до 255). Цветовая палитра состоит из 256 RGB-элементов. Определенный цвет 

– это результат применения значения от 0 до 255 для каждого из трех компонентов: 

красного, зеленого и синего. Если у красного, зеленого и синего компонентов одина-

ковые значения, то пиксель будет иметь определенный оттенок серого. 

Черно-белая палитра связывает различные оттенки серого с каждым цветом, 

таким образом создавая линейный и непрерывный переход серого от черного к бе-

лому. В палитре можно установить черному цвету значение 0, а белому – 255, и 

наоборот. Другие палитры могут отражать линейные или нелинейные переходы от 

красного к синему, от светло-коричневого к темно-коричневому и т. д. 

В NI Vision есть пять предопределенных цветных палитр. Каждая палитра вы-

деляет различные оттенки серого. Графики в каждом разделе представляют собой 

цветные таблицы, используемые каждой палитрой. По горизонтали располагаются 

входные оттенки серого (0, 255), а по вертикали – интенсивность RGB, соответству-

ющая данному оттенку серого. 
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В черно-белой палитре оттенок серого постепенно меняется от черного к 

белому. Чтобы воспроизвести оттенок серого, красному, зеленому и синему при-

сваивается одинаковое значение (рисунок 12, а). Температурная палитра пред-

ставляет собой переход от светло-коричневого к темно-коричневому. Черный 

цвет – 0, белый – 255 (рисунок 12, б). Радужная палитра характеризуется изме-

нением от синего к красному с заметной областью зеленого в средних значениях. 

Синий равен 0, красный – 255 (рисунок 12, в). В градиентной палитре красный 

изменяется к белому, присутствует заметная область светло-голубого при боль-

ших значениях. Черный – 0, белый – 255 (рисунок 12, г). Цвета 0 и 255 – частные 

случаи: 0 – это черный цвет, а 255 – белый. Эта циклическая палитра подходит 

для отображения бинарных и контурных изображений. 

 

  

а б 

  

в г 

 

а – черно-белая; б – температурная; в – радужная; г – градиентная  

 

Рисунок 12 – Варианты палитры 

 

В бинарной палитре присутствуют 17 циклов 15 различных цветов. Таб-

лица 3 иллюстрирует эти цвета, где g – оттенок серого. 

 

  

Би
бл
ио
те
ка

 БГ
УИ
Р



23 
 

Таблица 3 – Таблица цветов для бинарной палитры 

g = R G B Resulting Color (Конечный цвет) 

1 255 0 0 Красный – Red 

2 0 255 0 Зеленый – Green  

3 0 0 255 Синий – Blue 

4 255 255 0 Желтый – Yellow  

5 255 0 255 Фиолетовый (оттенок) – Purple  

6 0 255 255 Аква – Aqua 

7 255 127 0 Оранжевый 

8 255 0 127 Пурпурный – Magenta 

9 127 255 0 Ярко-зеленый – Bright green 

10 127 0 255 Фиолетовый – Violet 

11 0 127 255 Голубой – Sky blue 

12 0 255 127 Морской зеленый – Sea green 

13 255 127 127 Розовый – Pink 

14 127 255 127 Зеленая весна – Spring green 

15 127 127 255 Барвинок – Periwinkle 

 

Основываясь на статистической информации изображений (например, 

средний уровень яркости в области интереса), система может принимать реше-

ния в различных задачах инспектирования и контроля качества исследуемых 

объектов в автоматизированном режиме. К задачам подобного рода относятся 

обнаружение наличия или отсутствия объекта/компонента в заданной области, 

обнаружение дефектов исследуемых деталей, определение цвета путем его срав-

нения с образцом и т. д. 

Областью интереса (Region of Interest, далее – ROI) считается регион изоб-

ражения, выделенный для анализа, исследования и принятия решения. В СТЗ NI 

доступно три пути выделения ROI: 

- интерактивно в диалоговом режиме, по сути – вручную средствами NI; 

- программно – определив дескриптор с использованием координат и/или 

геометрических примитивов, доступных в NI; 

- с использованием масок – 8-битных предопределенных изображений-ма-

сок шаблонов, пикселями в которых заданы точки, подлежащие обработке. Если 

соответствующий пиксель маски отличен от 0, то соответствующий пиксель 

изображения подлежит заданному алгоритму обработки, в противном случае 

пиксель изображения игнорируется. 

К статистическим метрикам полутоновых изображений относятся следую-

щие характеристики: минимальные и максимальные значения интенсивности 
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ROI, средние значения интенсивности ROI, среднеквадратичное отклонение зна-

чений яркости ROI, процент отношения площади ROI к общей площади изобра-

жения. В данном случае в качестве ROI может выступать отдельный пиксель, 

линия, прямоугольник, замкнутая область произвольной формы. 
 

3.3  Анализ изображения: гистограммы 

Гистограмма высчитывает и показывает общее число пикселей каждого от-

тенка серого. Из графика можно сказать, содержит ли изображение области опре-

деленного оттенка серого. Гистограмма дает общее представление о параметрах 

изображения и помогает определить такие компоненты, как фон, объекты и 

шумы. 

Гистограмма – это основной инструмент анализа изображения, который 

описывает распределение интенсивности пикселей на изображении. Гисто-

грамма используется для определения соответствия уровня интенсивности изоб-

ражения для данной задачи, можно также использовать для установления нали-

чия определенных областей оттенка серого. С помощью гистограммы можно 

настраивать условия захвата изображения. 

Гистограмма – это функция H, определенная на интервале уровня серого 

[0, . . ., k, . . ., 255] таким образом, что число пикселей k равно 
 

𝐻(𝑘) =  𝑛𝑘, 
 

где k – значение уровня серого; nk – число пикселей изображения с уровнем серого, 

равным k;  ∑ 𝑛𝑘 (k = [0, 255]) – общее число пикселей изображения. 

На основе гистограммы можно определить два важных признака: насыщен-

ность и отсутствие контраста. 

Насыщенность. Недостаток освещения окружения приводит к недоэкспони-

рованию сенсора, в то время как обилие света вызывает передержку (насыщение) 

сенсора. Изображения, полученные при таких условиях, не могут содержать всю ин-

формацию о наблюдаемом месте. Важно заметить соответствующие условия визуа-

лизации и правильно настроить их. Недоэкспонирование или насыщение можно 

определить по гистограмме. В недоэкспонированном изображении есть много пик-

селей с низкими значениями оттенка серого. Они представлены в виде пиков в обла-

сти теней. В насыщенном изображении присутствует большое число пикселей с вы-

сокими значениями оттенка серого. 

Отсутствие контраста. Широко используемые типы графических приложе-

ний включают в себя просмотр и подсчет значимых частей изображения. Методика 

разделения объектов и фона зависит от разности их интенсивности, например яркий 

объект и темный фон. В таком случае при анализе гистограммы видны две и более 

вполне разделенные совокупности интенсивности. Устанавливать настройки изобра-

жения нужно до тех пор, пока в гистограмме полученного изображения не будет тре-

буемой приложением контрастности. 

На рисунке 13 гистограмма показывает, какой оттенок серого встречается 

чаще, а какой – реже. 
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Рисунок 13 – Диапазон уровня серого 

 

Гистограммы бывают двух типов: линейные (рисунок 14) и куммулятив-

ные (рисунок 15). В обоих случаях по оси абсцисс откладывается значение 

уровня серого (от 0 до 255). Ось ординат линейной гистограммы показывает 

число пикселей nk со значением уровня серого k, а ось ординат совокупной ги-

стограммы показывает процентное содержание пикселей с меньшим или равным 

значением k. 

 

Линейная гистограмма 

Функцией плотности распределения называется функция: 

 

𝐻𝑙𝑖𝑛𝑒𝑎𝑟(𝑘) =  𝑛𝑘, 

 

где Hlinear(k) – число пикселей k. 

 

Функцией вероятности называется функция: 

 

𝑃𝑙𝑖𝑛𝑒𝑎𝑟(𝑘) =  
𝑛𝑘

𝑛
, 

 

где Plinear(k) – вероятность того, что пиксель равен k. 

 

 
 

Рисунок 14 – Линейная гистограмма 

 

Куммулятивная гистограмма 

Функцией распределения называется функция 

 

𝐻𝑐𝑢𝑚𝑢𝑙(𝑘) =  ∑ 𝑛𝑖
𝑘
𝑖=0 , 

Би
бл
ио
те
ка

 БГ
УИ
Р



26 

 

 

где Hcumul(k) – число пикселей меньшее или равное k. 

 

Функцией вероятности называется функция 

 

𝑃𝑐𝑢𝑚𝑢𝑙(𝑘) =  ∑
𝑛𝑖

𝑛

𝑘
𝑖=0 , 

 

где Pcumul(k) – вероятность того, что пиксель меньше или равен k. 

 

 
 

Рисунок 15 – Куммулятивная гистограмма 

 

Интервалы уровня серого с концентрированным набором пикселей пока-

зывают наличие значимых элементов изображения, а также их относительные 

интервалы интенсивности. 

Линейная гистограмма показывает, что изображение состоит из трех ос-

новных компонентов. Совокупная гистограмма того же изображения показы-

вает, что два крайних слева пика составляют примерно 80 % изображения, в то 

время как остальные 20 % – это третий пик. 

 

Масштаб гистограммы 

Ось ординат гистограммы может быть линейного или логарифмического 

масштаба. Логарифмический масштаб позволяет отобразить значения уровня се-

рого, используемые небольшим числом пикселей. Эти значения могут пока-

заться неиспользуемыми при гистограмме, отображаемой в линейном масштабе. 

В логарифмическом масштабе по оси ординат откладывается логарифм числа 

пикселей по основанию значения серого. Использование малых значений уровня 

серого становится заметнее за счет превалирующих значений. При логарифми-

ческом масштабе выделяются малые значения, которые обычно не заметны при 

линейном масштабе. 

На рисунке 16 показана разница между гистограммами в логарифмическом 

и линейном масштабах. Здесь три пикселя равны нулю. 
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а       б 
 

а – линейная ось ординат; б – логарифмическая ось ординат 
 

Рисунок 16 – Гистограммы в логарифмическом и линейном масштабах 
 

3.4 Распознавание образов по шаблону 

Многие задачи распознавания объектов, решаемые с использованием ин-

струментария Vision NI, могут быть реализованы с применением функционала 

Pattern Matching – распознавание по шаблону или сопоставление с образцом. 

Сопоставление с образцом быстро определяет местоположение областей 

черно-белого (в градациях серого) изображения, которые соответствуют подхо-

дящему образцу, также рассматриваемому в качестве модели или шаблона. Под 

шаблоном будем подразумевать упрощенное представление совокупности опре-

деленных визуальных характеристик на изображении. 

При использовании сопоставления с образцом можно создать шаблон, 

представляющий искомый объект. Приложение машинного зрения ищет экзем-

пляры шаблона в каждом полученном изображении, считая каждое совпадение. 

Инструментарий «Сопоставление с образцом Vision NI» находит совпадения с 

шаблоном независимо от изменения освещения, размытия, шума и геометриче-

ских преобразований, например сдвиг или поворот. 

Алгоритмы сопоставления с образцом – одни из самых важных функций в 

машинном зрении по причине их использования в различных приложениях. Со-

поставление с образцом можно использовать в следующих трех общих приложе-

ниях: 

- выравнивание (Alignment) – определяет положение и ориентацию дан-

ного объекта путем нахождения реперных точек (точек выравнивания). Точки 

выравнивания используются как точки отсчета на объекте (например, угловые 

точки на изображениях QR-кодов); 

- измерение (Gauging) – измеряет длину, диаметр, углы и другие важные 

метрики. Если результат измерений не попадает в пределы допустимых отклоне-

ний, оцениваемый компонент отклоняется. Для нахождения объекта измерения 

может использоваться «Сопоставление с образцом»; 

- осмотр или инспектирование (Inspection) – обнаруживает небольшие не-

достатки, такие как отсутствие детали или «нечитабельность». 

Сопоставление с образцом предоставляет приложению в качестве выход-

ных данных количество экземпляров (совпавших объектов с шаблоном) и коор-
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динаты размещения объектов, совпавших с шаблоном в пределах данного изоб-

ражения. Например, можно искать изображение печатной платы с одной и более 

реперными точками (точками выравнивания).  

Приложение машинного зрения использует точки выравнивания для пра-

вильного расположения платы. Часть печатной платы показана на рисунке 17, а. 

Искомая точка выравнивания (шаблон), используемая при просмотрах печатной 

платы или в приложениях по установке чипа, изображена на рисунке 17, б. 

 

 
а          б 

 

а – печатная плата; б – шаблон 

 

Рисунок 17 – Использование распознавания по шаблону для поиска точек  

выравнивания на печатной плате 

 

Сопоставление с образцом предоставляет быстрый алгоритм общего 

назначения для определения местоположения объекта на изображении. Тем не 

менее сопоставление с образцом не подходит для приложений, где определяе-

мый объект масштабируется (рисунок 18, а) или больше 10 % изображения за-

крыто (рисунок 18, б).  

Неравномерное освещение (рисунок 18, в) изображения может уменьшить 

эффективность сопоставления с образцом. Приложениям, которые могут столк-

нуться с такими условиями, следует воспользоваться геометрическим сопостав-

лением. 
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а     б    в 

 

а – объект масштабируется; б – более 10 % изображения закрыто;  

в – неравномерное освещение 

 

Рисунок 18 – Ограничения по применению распознавания по шаблону 

 

Так как алгоритм сопоставления с образцом – это первый этап во многих 

приложениях машинного зрения, он должен надежно работать в различных усло-

виях. В приложениях автоматизированного машинного зрения визуальное пред-

ставление проверяемых материалов или компонентов может измениться по при-

чине различных факторов: ориентация детали, изменение масштаба и изменения 

света. Инструмент сопоставления с образцом должен находить эталонные об-

разцы несмотря на все эти изменения. На страницах 31–36 описаны наиболее 

распространенные применяемые алгоритмы, в которых инструмент сопоставле-

ния с образцом должен вернуть точные результаты. 

Алгоритм сопоставления с образцом должен определить местонахождение 

эталонного образца на изображении, даже если образец на изображении повер-

нут или изменен в масштабе. В подобной ситуации инструмент сопоставления с 

образцом может определить на изображении следующее: 

- эталон; 

- позицию эталона на изображении; 

- ориентацию эталона; 

- многочисленные экземпляры эталона (если возможно); 

Изображение-шаблон показано на рисунке 19, а. Многочисленные экзем-

пляры шаблона иллюстрирует рисунок 19, б–г : сдвинутое сопоставление с шаб-

лоном изображено на рисунке 19, б; повернутое сопоставление с шаблоном – на ри-

сунке 19, в; масштабируемое сопоставление с шаблоном – на рисунке 19, г.  
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а   б    в   г 

 

а – изображение-шаблон; б – сдвинутое сопоставление с шаблоном;  

в – повернутое сопоставление с шаблоном; г – масштабируемое сопоставление 

с шаблоном 

 

Рисунок 19 – Пример корректной работы инструмента «Сопоставление  

с образцом» в условиях масштабирования и поворотов обрабатываемых  

изображений 

 

Алгоритм сопоставления с образцом должен иметь возможность находить 

эталонный образец на изображении в условиях равномерных изменений освеще-

ния на всем изображении. На рисунке 20 показаны типичные условия, в которых 

сопоставление с образцом функционирует правильно: при ярком освещении – на 

рисунке 20, б, при слабом освещении – на рисунке 20, в. 

 

 

а   б        в 

 

а – исходное изображение шаблона; б – изображение шаблона при ярком                

освещении; в – изображение шаблона при слабом освещении 

 

Рисунок 20 – Изображение шаблона при разных уровнях освещенности 

 

Алгоритм сопоставления с образцом должен иметь возможность находить 

образцы, которые подверглись некоторым преобразованиям: размытию и шуму. 

Обычно размытие происходит из-за неправильной фокусировки или изменений 

глубины резкости. Обратитесь к настройкам системы и калибровки для получе-

ния подробной информации о глубине резкости.  

На рисунке 21 показаны типичные условия шума и размытия, в которых 

сопоставление с образцом функционирует правильно: изменение изображения 

из-за размытия – на рисунке 21, б, из-за шума – на рисунке 21, в. 
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     а   б           в 

 

а – исходное изображение шаблона; б – изменение изображения  

из-за размытия; в – изменение изображения из-за шума 

 

Рисунок 21 – Образцы размытия и «зашумления» изображений 

 

В NI Vision применяются два метода распознавания образцов по шаблону – 

пирамидальное сопоставление и распознавание изображения (небольшое разли-

чие образцов). В обоих методах используется нормированная взаимнокорреля-

ционная функция в качестве базовой технологии. 

Процесс сопоставления с образцом состоит из двух этапов: обучение и рас-

познавание (сопоставление). Во время этапа обучения извлекается информация 

о значениях оттенков серого и/или данные о градиентах краев/границ из изобра-

жения шаблона. Информация систематизируется и сохраняется таким образом, 

чтобы ускорить поиск в проверяемом изображении. В NI Vision информация, по-

лученная на этом этапе, сохраняется как часть изображения шаблона.  

Во время этапа сопоставления соответственно извлекается информация о 

значениях оттенков серого и/или данные о градиенте краев из проверяемого 

изображения (соответствующая информация из шаблона и с применением ана-

логичных алгоритмов). Затем алгоритм находит наибольшие совпадения путем 

определения местоположения областей проверяемого изображения, где наблю-

дается самая высокая взаимная корреляция. 

Нормированная взаимная корреляция – наиболее распространенный метод 

нахождения шаблона на изображении. Процесс корреляции занимает много вре-

мени по причине того, что основной механизм вычисления корреляции основан 

на выполнении серии умножений. Такие технологии, как MMX-инструкции 

(Multimedia Extensions – мультимедийные расширения, дополнительный набор 

инструкций), позволяют реализовать параллельное умножение и уменьшают об-

щее время вычислений. Для увеличения скорости процесса сопоставления 

можно уменьшить размер изображения и ограничить нужную область. Пирами-

дальное сопоставление и распознавание изображения – два метода увеличения 

скорости процесса сопоставления. 

Нормированная взаимная корреляция – отличный метод нахождения об-

разцов на изображении, если только они не повернуты или изменены в масштабе. 

Обычно с помощью взаимной корреляции можно определить образцы одинако-

вого размера, повернутые в пределах от 5 до 10°. 

Для инвариантного сопоставления относительно масштабирования необ-

ходимо повторить этап масштабирования и изменения размера шаблона и затем 
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выполнить операцию корреляции. В результате к процессу сопоставления до-

бавляется значительное количество вычислений.  

В случае поворота все значительно сложнее. Если по исследуемому изоб-

ражению можно вычислить угол поворота и понять, насколько повернут объект, 

то можно просто повернуть шаблон и выполнить корреляцию. В случае если про 

поворот ничего неизвестно, для поиска лучшего соответствия требуется выпол-

нить полный цикл последовательных поворотов шаблона с последующим выпол-

нением вычислений корреляции и сравнения с шаблоном. 

Используя подход сопоставления «от грубого к точному» и пирамидальное 

сопоставление или распознавание изображения, можно избежать значительных 

вычислений и достичь приемлемого времени поиска и обработки повернутых об-

разцов. Тем не менее сопоставление, инвариантное относительно масштабирова-

ния, не всегда поддерживается даже при использовании пирамидального сопо-

ставления или распознавания изображения. 

Можно улучшить время вычисления при сопоставлении образцов путем 

уменьшения размера изображения и шаблона. В пирамидальном сопоставлении 

при помощи гауссовской пирамиды для изображения и шаблона создаются об-

разцы в меньшем разрешении (рисунок 22). В этом методе берется образец каж-

дого пикселя, и затем изображение и шаблон могут быть уменьшены на одну 

четверть их первоначального размера для каждого последующего уровня пира-

миды. 

 

 

 

Рисунок 22 – Пирамидальное сопоставление при помощи гауссовской  

пирамиды 

 

На этапе обучения алгоритм автоматически вычисляет максимальный уро-

вень пирамиды, который можно использовать для данного шаблона, и изучает 

данные, необходимые для представления шаблона и его повернутых версий для 

всех уровней пирамиды. Алгоритм стремится найти оптимальный уровень пира-

миды (основываясь на анализе данных шаблона), который даст самое быстрое и 

точное совпадение. Могут быть использованы два вида данных: значения уровня 
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серого (основанные на интенсивности пикселей) и градиенты (основанные на 

данных о краях и границах). 

Метод значений уровня серого использует нормированные пиксельные 

значения уровня серого в качестве характеристик. Это гарантирует, что инфор-

мация не потеряется, что является полезным при отсутствии у шаблона структу-

рированных данных, но при наличии у него сложной текстуры или плотных 

краев. Тем не менее у этого метода есть недостаток, который проявляется при 

окклюзии (перекрытие объекта на изображении) и неоднородных изменениях 

освещения. Несмотря на эти ограничения, метод работает для множества сцен и 

подходит для общего использования.  

Градиентный метод использует отфильтрованные пиксели края в каче-

стве характеристик. Изображение края вычисляется из прилагаемого черно-бе-

лого изображения, порог интенсивности градиента вычисляется на основе ана-

лиза изображения шаблона. Все векторы края, которые сильнее, чем пороговые, 

остаются в качестве характеристик. Совпадение лучше основывается на векторе 

корреляции, чем на нормированной взаимной корреляции (рисунок 23).  
 

 
 

Рисунок 23 – Градиентный метод 
 

Этот метод менее восприимчив к окклюзии и изменениям интенсивности 

освещения по сравнению с методом значений уровня серого, так как меньше дан-

ных должно быть обработано. Но в связи с тем, что при низком разрешении 

уменьшается плотность и достоверность краев, этот метод требует от пользова-

теля работы с более высокими разрешениями, чем метод значений уровня серого. 

На этапе сопоставления используется грубо-точный подход, начиная по-

иск с самого низкого возможного разрешения (что соответствует самому высо-

кому уровню пирамиды). Поскольку размеры обрабатываемого изображения и 

шаблона были значительно уменьшены, мы можем провести исчерпывающий 

поиск, основанный на корреляции. Тем не менее в процессе обработки умень-

шенных «подобразцов» теряются некоторые детали и места совпадений не 

вполне точны.  
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Данная проблема решается путем сохранения списка координат наилуч-

ших совпадений с количественной оценкой близости образца и шаблона, а не 

просто координат с учетом количества близких паттернов. Затем для каждого из 

более низких уровней пирамиды процесс повторяется для самых подходящих об-

разцов из списка более высокого уровня, уточняя список совпадений на каждом 

этапе путем его вычисления заново. Этот подход сужает области поиска вокруг 

наиболее подходящих совпадений, что дает существенное повышение скорости. 

При поиске повернутых шаблонов выполнение вычислений для всех воз-

можных поворотов (от 0 до 360°) достаточно трудоемко, даже при низких разре-

шениях. Следовательно, сперва необходимо найти все ближайшие совпадения на 

больших шагах угла. Самые близкие совпадения детализируются на более мел-

ких шагах угла. После этого будет выполняться тот же метод, что описан ранее 

путем уточнения мест совпадений, а также углов в последующих более низких 

уровнях пирамиды. 

Особенность сопоставления с образцом – это отличительный (выделяю-

щийся) образец пикселей, описывающий шаблон. По причине того, что боль-

шинство изображений содержит избыточную информацию, использование всей 

информации для сопоставления образцов является длительным и неточным. 

В NI Vision используется неоднородный метод получения образцов, кото-

рый совмещает тщательное распознавание изображения и эффективное описа-

ние шаблона. Этот «умный» метод включает в себя сочетание пикселей края и 

пикселей области, как показано на рисунке 24. Похожий метод применяется, ко-

гда пользователь указывает, что образец может быть повернут. Этот метод ис-

пользует специально выбранные пиксели, чьи значения (или соответствующие 

изменения значений) отражают поворот образца. Умная подготовка и предобра-

ботка образцов уменьшает излишек информации и подчеркивает особенности, 

чтобы сделать возможным эффективное осуществление взаимной корреляции. 

 

 
 

Рисунок 24 – Неоднородный метод получения образцов 

 

Сопоставление с образцом в NI Vision способно определить местонахож-

дение объектов, которые различаются размером (±5 %) и ориентацией (от 0 до 

360°), а также имеют искажения в визуальном отображении изображения. 

Нормированная взаимнокорреляционная функция – это базовый принцип 

корреляции. Рассмотрим часть изображения w (x, y) размером  K × L в пределах 
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изображения  f (x, y) размером M × N, где K ≤ M и L ≤ M. Корреляция между 

w (x, y) и f (x, y) в точке (i, j) рассчитывается как 

 

𝐶(𝑖, 𝑗) =  ∑ ∑ 𝑤(𝑥, 𝑦)𝑓(𝑥 + 𝑖, 𝑦 + 𝑗)𝐾−1
𝑦=0

𝐿−1
𝑥=0 , 

 

где i = 0, 1, …, M–1 и j = 0, 1, …, N–1, 

и суммирование выполняется по всей области, где w и f перекрываются.  

На рисунке 25 показана операция корреляции, в которой начало изображе-

ния f находится в левом верхнем углу.  

 
 

Рисунок 25 – Операция корреляции 

 

Корреляция – это процесс перемещения шаблона или части изображения w 

по области изображения и вычисления значения C. Включает в себя умножение 

каждого пикселя шаблона на пиксель изображения, который его перекрывает, 

затем суммирование результатов для всех пикселей шаблона.  

Вычисление нормированной кросс-корреляции и отображение ее поверхно-

сти. Пики матрицы кросс-корреляции, которые попали на подызображение, сви-

детельствуют о наивысшей корреляции. Максимальное значение C указывает 

место, где w лучше совпадает с f. Значения корреляции неточны на границах 

изображения (рисунок 26). 
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Рисунок 26 – Нормированная кросс-корреляция и поиск координат пиков  

 

3.5 Распознавание Barcode и QR-кодов 

С помощью инструментов Vision NI можно также построить прототип си-

стемы автоматизированного распознавания штрихкодов, в частности QR- и 

DataMatrix-кодов. 

Штрихкоды в магазинах, рекламных объявлениях, на почте, выставках, в 

производстве для маркировки продукции стали уже повседневным атрибутом. 

Тенденции развития штрихкодов состоят в увеличении объемов шифруемой ин-

формации с одновременным уменьшением площади, занимаемой самим кодом. 

Самый распространенный полосковый штрихкод использует одномерную си-

стему кодирования, тогда как двухмерный уже расшифровывается как по гори-

зонтали, так и по вертикали. Перед привычным линейным штрихкодом у двух-

мерного есть серьезные преимущества: больший объем хранимой информации и 

возможность ее восстановления до 30 % поврежденной площади. 

Самые распространенные стандарты двухмерных кодов – это DataMatrix, 

изобретенный в 1989 году, и QR-код («QuickResponse», то есть «Быстрый от-

клик»), разработанный в 1994 году японской компанией Denso Wave Inc (рису-

нок 27). Ключевое отличие QR от DataMatrix – умение работать с кана-симво-

лами японского языка. 
 

  

а    б 

 

а – DataMatrix; б – QR-code 
 

Рисунок 27 – Примеры штрихкодов (на обоих закодировано www.bsuir.by) 
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Спецификация QR-кода исчерпывающе изложена в стандарте 

ISO/IEC18004. Три квадрата в углах изображения (рисунок 27, б) и меньшие син-

хронизирующие квадратики по всему коду позволяют нормализовать размер 

изображения и его ориентацию, а также угол, под которым сенсор относится к 

поверхности изображения. Точки переводятся в двоичные числа с проверкой по 

контрольной сумме (рисунок 28).  

 

 
 

Рисунок 28 – Описание полей QR-кода 

 

Штрихкод DataMatrix на 30–60 % меньше по площади, чем QR, содержа-

щий идентичные данные. DataMatrix – типичный представитель семейства 2D-

баркодов, позволяющий закодировать до 3 Кбайт информации. DataMatrix, как и 

все другие подобные баркоды, содержит сведения для восстановления, которые 

позволяют восстановить закодированную информацию при частичном повре-

ждении кода.  

Каждый код DataMatrix содержит две сплошные пересекающиеся линии в 

виде буквы L для ориентации считывающего устройства (обычно слева и снизу 

диаграммы), две другие границы кода состоят из перемежающихся черных и бе-

лых точек и служат для указания размеров кода считывающему устройству (ри-

сунок 29). 

 

 
 

Рисунок 29 – Области границ и полезной информации DataMatrix-кода 
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Особенности DataMatrix-кода: 

- стандартизация (принят международный стандарт ISO/IES16022, гото-

вится российский стандарт); 

- большая информационная емкость (более 2000 букв или 3000 цифр); 

- высокая скорость распознавания и декодирования; 

- низкие требования к качеству поверхности, на которую наносится метка; 

- распознавание не зависит от фона изображения. 

У символа допускается две формы – квадрат и прямоугольник. Это облег-

чает вписывание метки в имеющееся на изделии пространство. 

Коды DataMatrix используют коррекцию ошибок стандарта ECC200, 

ECC 000-140, который в свою очередь использует алгоритм Рида – Соломона 

(Reed – Solomon) для кодирования/декодирования данных. Это позволяет восста-

новить в случае повреждения кода до 30 % полезной информации. DataMatrix- 

коды становятся привычным явлением на конвертах и посылках. Такой код мо-

жет быть быстро прочитан сканером, что позволяет отслеживать корреспонден-

цию довольно эффективно. В промышленности DataMatrix применяют для мар-

кировки различных элементов.  

 

3.6 Отслеживание объекта 

Трекинг объекта предназначен для отслеживания местоположения объекта 

в видеопоследовательности (ряде изображений). Этот метод заключается в от-

слеживании объекта по последовательным кадрам для определения движения 

данного объекта на изображении относительно других. При использовании ин-

струмента Vision NI «Отслеживание объекта» пользователь должен определить 

местоположение объекта и установить его. Затем методами «отслеживания объ-

екта» объект отслеживается в каждом кадре, в котором он присутствует. 

Отслеживание объекта – это важная функция машинного зрения, полу-

чившая широкое применение в следующих областях: 

- безопасность и скрытое наблюдение: в сфере скрытого наблюдения могут 

отслеживаться такие объекты наблюдения, как люди и транспортные средства. 

Отслеживание объекта может использоваться для обнаружения неразрешенного 

проникновения или слежения за аномалиями, например несопровождаемый багаж; 

- управление трафиком: при анализе транспортного потока могут быть об-

наружены столкновения; 

- медицина: можно отслеживать клетки на медицинских изображениях; 

- промышленность: можно обнаружить и отследить дефектные детали; 

- робототехника и навигация: роботы могут следовать траектории объекта, 

робот-помощник может маневрировать на фабрике (объекты разгрузки); 

- человеко-компьютерное взаимодействие: можно отслеживать пользова-

телей в игровой среде; 

- объектное моделирование: объект, отслеживаемый с различных точек, 

может быть использован для создания частичной трехмерной модели; 
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- биомеханика: отслеживание тела для толкования жестов или движений. 

Хорошо сконфигурированное приложение «Отслеживания объекта» от-

слеживает объекты независимо от их размытия, шума или частичной окклюзии. 

В NI Vision при отслеживании объектов допустимы постепенные изменения в 

отслеживаемом объекте, включая геометрические преобразования, такие как 

сдвиг, поворот или изменение масштаба. Отслеживание объекта в NI Vision мо-

жет использоваться в черно-белом (U8, U16 и I16) или цветном (RGB32) изобра-

жении. 

NI Vision использует два алгоритма отслеживания объекта: 

- средний сдвиг – простой алгоритм, который отслеживает пользователь-

ские объекты путем итерационного обновления местоположения объекта; 

- средний сдвиг на основе ЕМ-алгоритма (средний сдвиг для форм) – рас-

ширенная версия алгоритма среднего сдвига, в котором адаптируется кадр за 

кадром не только местоположение, но и форма объекта, учитывая изменение 

масштаба. 

Чтобы отследить паттерн, целевой объект должен быть охарактеризован 

через пространство признаков. Гистограмма цвета – достаточно точное представ-

ление внешнего вида объекта, поэтому данный вариант выбран в качестве про-

странства признаков в инструментах Object Tracking Vision NI. Движение объек-

тов описывается с использованием гистограмм. Целевые представления, осно-

ванные на гистограмме признаков, упорядочиваются с помощью применения 

пространственной фильтрации (использование масок и фильтров) и ненаправ-

ленного ядра. 

Алгоритм среднего сдвига – это простой способ нахождения позиции ло-

кального экстремума (локальный максимум) путем оценки на базе ядра функции 

вероятностной плотности. Трекинг объекта на кадре выполняется сочетанием из-

влечения гистограммы, вычисления веса и вывода нового местоположения от-

слеживаемого объекта. 

Алгоритм среднего сдвига содержит следующие три этапа: 

- целевая модель: выберите целевой объект в данном кадре, представьте 

целевую модель в данном пространстве признаков (цветовая гистограмма) с яд-

ром; 

- сходимость среднего сдвига: в следующем кадре ищите с помощью теку-

щей гистограммы и пространственных данных лучшее совпадение по целевой 

функции, максимизируя функцию подобия, так как в алгоритме среднего сдвига 

центр объекта перемещается с текущей позиции на новую, ядро сдвигается до 

достижения сходимости функции подобия, затем местоположение объекта об-

новляется (рисунок 30); 
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Рисунок 30 – Поиск сходимости среднего сдвига 

 

- обновление местоположения и модели: обновляется целевая модель и ме-

стоположение целевого объекта, основываясь на параметрах совмещения/сты-

ковки (рисунок 31). 
 

 

 

Рисунок 31 – Обновление местоположения и модели 
 

Исходный алгоритм среднего сдвига не инвариантен относительно мас-

штабирования или сдвига. Для отслеживания объекта, размер или форма кото-

рого может измениться, требуется алгоритм среднего сдвига на основе ЕМ-алго-

ритма. 

Алгоритм среднего сдвига на основе ЕМ-алгоритма (или средний сдвиг 

для форм) – это, как уже было указано, расширение стандартного алгоритма. По-

следовательно оценивает позицию локального фильтра и матрицы ковариаций, 

которая описывает аппроксимированную форму локального фильтра. Матрица 

ковариаций, устанавливающая форму и масштабирование области, обновляет 

каждый кадр для изменения формы и масштаба объекта на этом кадре. 

Три этапа данного алгоритма: 

- целевая модель: выберите целевой объект в данном кадре, представьте 

целевую модель в данном пространстве признаков (цветовая гистограмма) с яд-

ром; 

- сходимость среднего сдвига: в следующем кадре ищите с помощью теку-

щей гистограммы и пространственной фильтрации лучшее совпадение, макси-

мизируя функцию подобия, так как в алгоритме среднего сдвига центр объекта 
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(по существу, центр масс) перемещается с текущей позиции на новую (расстоя-

ние и направление движения представлены вектором среднего сдвига), ядро 

сдвигается до достижения сходимости функции подобия, затем местоположение 

объекта обновляется совместно с ковариацией ядра; 

- обновление местоположения и модели: обновляется целевая модель и ме-

стоположение целевого объекта, основываясь на параметрах совмещения/сты-

ковки, а также предельно допустимых изменениях масштаба и формы (рису-

нок 32). 

 

 

 

Рисунок 32 – Обновление местоположения и модели с учетом  

масштабирования 
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4 Лабораторные работы 

 

Для выполнения всех лабораторных работ необходимы: интеллектуальная 

камера NI Smart Camera, программное обеспечение Vision Builder AI.  

 

 Порядок выполнения и защиты лабораторных работ 

Общие цели каждой лабораторной работы: 

 - создание общего теоретического фундамента в области анализа изобра-

жений, знакомство с базовыми математическими методами и алгоритмическими 

процедурами, выработка навыка самостоятельной работы; 

 - ознакомление с возможностями интеллектуальной камеры NI Smart Cam-

era, программного обеспечения Vision Builder AI в области обработки изображе-

ния, основными средствами и областью их применения. 

Объектом изучения при проведении лабораторных занятий настоящей 

дисциплины является моделирование в программно-аппаратных средствах от-

дельных элементов систем технического зрения и систем обработки изображе-

ния в целом.  

Лабораторные работы выполняются студентами согласно установленного 

в начале семестра расписания. Лабораторная работа выполняются исследова-

тельской группой, не превышающей 2 человека.  

В процессе подготовки и выполнения лабораторных работ студенты 

должны:  

- понять смысл, содержание и значимость целей каждой предлагаемой для 

выполнения лабораторной работы;  

-усвоить и понимать положения теории, относящиеся к особенностям изу-

чения объекта исследования;  

- понять особенности методов (моделей) применяемых для наблюдения, 

контроля, измерений и вычислений в ходе выполнения лабораторной работы;  

- понять обоснованность применения в лабораторной работе конкретных 

средств наблюдения, измерения, контроля и моделей.  

Лабораторная работа считается выполненной после соответствующего 

оформления, обсуждения и защиты работы с обоснованием полученных резуль-

татов лабораторных исследований.  

Отчет по лабораторной работе должен включать в себя:  

1. Титульный лист.  

2. Краткое теоретическое рассмотрение решаемой задачи.  

3. Описание решения задачи. В данном разделе, относящемся к поста-

новке эксперимента, необходимо дать подробное описание используемых ме-

тодов, последовательности операций, способов и приемов, которые характе-

ризуют технологию решения задачи. Необходимо привести алгоритм и про-

граммный код.  

4. Анализ полученных результатов. Основной акцент дается на главный 

результат. Указывается  область  варьируемых  параметров  эксперимента, в   
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которых полученный результат устойчив. Проводится сравнение полученных 

результатов с теоретическими выводами, обсуждаются их расхождения, и де-

лается попытка их объяснения.  

5. Выводы и заключение. Отмечается суть выполненной работы, делаются 

выводы.  

 

 

4.1 ЛАБОРАТОРНАЯ РАБОТА №1 

 Основы работы с интеллектуальной камерой National Instruments. 

Решение простейших прикладных задач 

 

Задание: 

1. Выполнить упражнения: 

Упражнение 1. Исследование фиксирующего кольца. 

Упражнение 2. Исследование этикетки. 

Упражнение 3. Исследование коннектора. 

2. Определить основные этапы решения задач. 

3. Изучить алгоритмы обработки и анализа изображений, используемые 

при решении указанных задач. 

4. Указать, какие инструменты Vision Builder AI были использованы. 

 

 

УПРАЖЕНИЕ 1. Исследование фиксирующего кольца 

Это упражнение демонстрирует простейшие варианты использования ин-

струментов для проведения измерений, доступных в Vision Builder AI. В этом 

упражнении вы будете исследовать фиксирующие кольца и научитесь измерять 

их радиус. Вы будете искать два отверстия для фиксации на кольце и проверять 

их размеры. Вы также будете использовать светодиоды PASS/FAIL на умной ка-

мере, чтобы отображать статус исследования. 

 

Создание нового исследования 
Следуйте приведенным ниже инструкциям, чтобы создать новое исследо-

вание. 

1. Выберите Пуск » Программы » National Instruments » Vision Builder 

AI, чтобы запустить Vision Builder AI. Если Vision Builder AI уже запущен, за-

кройте все открытые исследования. 

2. На экране приветствия Vision Builder AI выберите NI Smart Camera в 

списке целей. 

3. Кликните New Inspection, чтобы запустить конфигурационный интер-

фейс. Рисунок 33 показывает основные компоненты конфигурационного интер-

фейса. 
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Рисунок 33 – Интерфейс 

 

Получение изображений для исследования 
Умная камера должна стробировать кольцо света и снимать изображение 

каждый раз, когда она получает сигнал по линии ISO Input 0. 

Следуйте приведенным ниже инструкциям, чтобы настроить получение 

изображения для исследования. 

1. Установите диск с фиксирующим кольцом на вращающуюся плат-

форму. Убедитесь, что он твердо закреплен на платформе. 

2. В палитре Inspection Steps перейдите на вкладку Acquire Images. 

3. Щелкните на Acquire Image (Smart Camera).  

Откроется окно свойств. 

4. В поле Step Name введите Acquire Image. 

5. Установите Exposure Time (ms) в значение 0.504. 

6. Установите Gain в значение 170. 

7. Перейдите на вкладку Lighting. Щелкните на Configure Light, чтобы 

открыть соответствующее диалоговое окно. Так как источник света, используе-

мый в этом примере, является предустановленным по умолчанию, вы можете вы-

брать его из списка предустановленных источников света. 

8. Выберите National Instruments » RL1424-660 (Ring Light, Red) и 

нажмите OK. RL1424 – это предустановленный источник света. 

9. Убедитесь, что вы выбрали корректный источник света диалоговом 

окне Confirm Light Selection. Нажмите Yes. 
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Предупреждение! Выбор неправильного источника света в пунктах 7 и 9 может 

повредить электрические схемы камеры и сам источник света. Убедитесь, что вы 

выбрали правильный источник света. 

 

10. Активируйте флажок Enable Direct Drive Lighting. Это включит све-

тодиодное кольцо света, подключенное к умной камере. 

11. Установите Direct Drive Lighting Mode в режим Strobed. 

12. Установите Desired Current Level (mA) в значение 1000. 

13. Во вкладке Trigger активируйте флажок Triggered Acquisition и уста-

новите Trigger Polarity в Falling Edge. 

14. Вращайте исследуемый диск и нажмите кнопку Grab         , чтобы про-

тестировать конфигурацию. Обратите внимание, что получение изображения 

срабатывает в тот момент, когда кольцо проходит под умной камерой. Изобра-

жение должно быть подобно представленному на рисунке 34. 

15. Нажмите OK, чтобы завершить настройку получения изображения. 

 

 

 
  

Рисунок 34 – Полученное изображение стопорного кольца 

 

Измерение диаметра фиксирующего кольца 
Деталь считается бракованной, если диаметр фиксирующего кольца не 

находится в диапазоне между 210 и 240 пикселями. 
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Следуйте приведенным ниже инструкциям, чтобы измерить диаметр фик-

сирующего кольца. 

1. В палитре Inspection Steps перейдите на вкладку Locate Features. 

2. Щелкните на Find Circular Edge         . Откроется окно свойств. 

3. В поле Step Name введите Measure Diameter. 

4. Щелкните в центре фиксирующего кольца и перетащите курсор за 

пределы кольца, чтобы нарисовать регион интереса (Region of Interest, ROI). Из-

мените центр, внутренний радиус и внешний радиус ROI, как показано на ри-

сунке 35. 

 

 
 

Рисунок 35 – Нарисованный регион интереса для кольца 

 

5. Во вкладке Limits активируйте флажок Minimum Diameter (pix) и 

установите значение 210.00. 

6. Активируйте флажок Maximum Diameter (pix) и установите зна-че-

ние 240.00. 

7. Нажмите OK, чтобы добавить шаг в исследование. 

 

Обнаружение отверстий для фиксации на кольце 

Необходимо убедиться, что в фиксирующем кольце есть два отверстия для 

фиксации и что отверстия имеют площадь между 250 и 350 квадратными пиксе-

лями. 

Следуйте приведенным ниже инструкциям. 

1. В палитре Inspection Steps перейдите на вкладку Check for Presence. 

2. Щелкните на Detect Objects          . Откроется окно свойств. 

3. В поле Step Name введите Check Retainer Holes. 

4. Во вкладке Threshold в поле Method выберите Local Threshold: 

Niblack. 
5. Нарисуйте прямоугольный ROI таким образом, чтобы оба отверстия 

для фиксации находились у него внутри, как показано на рисунке 36. 
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Рисунок 36 – Прямоугольный ROI 

 

6. Во вкладке Settings активируйте флажок Minimum Object Size и 

установите значение 250.00. 

7. Активируйте флажок Maximum Object Size и установите значение 

350.00. 

8. Во вкладке Limits активируйте флажок Minimum Number of Ob-

jects и установите значение 2. 

9. Активируйте флажок Maximum Number of Objects и установите 

значение 2. Шаг выполнится успешно, только если есть два отверстия площадью 

250–350 квадратных пикселей внутри ROI. 

10. Нажмите OK, чтобы добавить шаг в исследование. 

 

Установка статуса исследования 

После того как вы определите, прошла ли деталь проверку на брак, вы 

должны установить переменную Inspection Status соответствующим образом. 

Следуйте приведенным ниже инструкциям, чтобы установить Inspection 

Status на основании результатов, полученных на шаге Check Retainer Holes.   

 

1. В палитре Inspection Interface перейдите на вкладку Use Additional Tools. 

2. Щелкните на Set Inspection Status  . Откроется окно свойств. 

3. В поле Inspection Status выберите Set to FAIL if any previous step fails. 

4. Нажмите OK, чтобы добавить шаг в исследование. 

 

Создание пользовательского индикатора 

Следуйте приведенным ниже инструкциям, чтобы отобразить булев ин-

дикатор, показывающий, является ли деталь бракованной, на изображении. 
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1. Во вкладке Custom Overlay щелкните на Indicator Tool     и нарисуйте 

прямоугольник в центре фиксирующего кольца. 

2. В поле Value выберите System Variable – Inspection Status. 

3. В поле True Text введите PASS. 

4. В поле False Text введите FAIL. 

5. Нажмите OK, чтобы добавить шаг в исследование. 

 

Светодиоды PASS/FAIL 

Светодиоды PASS и FAIL расположены на умной камере NI 17xx. Исполь-

зуя эти светодиоды, умная камера может сообщать, является ли деталь бракован-

ной. 

Следуйте приведенным ниже инструкциям, чтобы активировать светоди-

оды PASS и FAIL. 

1. В палитре Inspection Steps перейдите на вкладку Communicate.  

2. Щелкните на Read/Write I/O         . Откроется окно свойств. 

3. В поле Step Name введите Smart Camera I/O. 

4. В таблице Digital Output Lines активируйте флажок Pass LED. 

5. Установите Value в значение System Variable – Inspection Status и Po-

larity в значение Drive High if Pass. 

6. В таблице Digital Output Lines активируйте флажок Fail LED. 

7. Установите Value в значение System Variable – Inspection Status и Po-

larity в значение Drive High if Fail. 

8. Нажмите OK, чтобы добавить шаг в исследование. 

 

Сохранение и запуск исследования 
Следуйте приведенным ниже инструкциям, чтобы сохранить исследование 

и запустить его в режиме интерфейса исследования.   

1. Выберите File → Save или нажмите кнопку Save на панели инструмен-

тов. 

2. Введите Ring Inspection в поле Inspection Name. 

3. Щелкните на Save         , чтобы сохранить исследование. 

 

Подсказка. Выберите File → Inspection Properties, чтобы добавить краткое опи-

сание или комментарии об исследовании. 

 

4. Щелкните File → Switch to Inspection Interface. На короткое время окно 

закроется и снова откроется в режиме интерфейса исследования.   

5. Нажмите кнопку Start Inspection          и вращайте диск. 

6. Обратите внимание, как моргают светодиоды PASS и FAIL по мере вра-

щения деталей под умной камерой. 
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Заметка. Если вы будете вращать диск слишком быстро, кадры могут пропус-

каться.  

 

7. Нажмите кнопку Stop Inspection , чтобы остановить 

исследование деталей. 

8. Выберите Inspection → Switch to Configuration Interface, чтобы вер-

нуться в интерфейс настройки. 

 

 

УПРАЖЕНИЕ 2. Исследование этикетки 

Это упражнение показывает, как использовать Vision Builder AI вместе с 

умной камерой. Необходимо исследовать этикетку на упаковке фармацевтиче-

ского продукта, прочитать и проверить 2D-код, размещенный на ней. Если каче-

ство штрихкода плохое, то упаковка считается бракованной и будет отброшена 

с использованием линий ввода-вывода на умной камере. 

 

Создание нового исследования 
Следуйте приведенным ниже инструкциям, чтобы создать новое исследо-

вание. 

1. Выберите Пуск → Программы → National Instruments → Vision 

Builder AI, чтобы запустить Vision Builder AI. Если Vision Builder AI уже запу-

щен, закройте все открытые исследования. 

2. На экране приветствия Vision Builder AI выберите NI Smart Camera в 

списке целей. 

3. Щелкните на New Inspection, чтобы запустить конфигурационный ин-

терфейс. Рисунок 33, размещенный в упражнении 1, показывает основные ком-

поненты конфигурационного интерфейса. 

 

Получение изображений для исследования 

Smart Camera Demo Kit имеет манипулятор NI 17xx, направленный на вра-

щающийся диск, расположенный строго под ним. С дальнего конца базы устрой-

ства внизу под диском расположен датчик приближения, который посылает сиг-

нал умной камере по линии ISO Input 0 в тот момент, когда деталь попадает точно 

под умную камеру. Для данного упражнения установите диск с фармацевтиче-

ской этикеткой на вращающуюся платформу. Убедитесь, что он твердо закреп-

лен на платформе. Умная камера должна стробировать кольцо света и снимать 

изображение каждый раз, когда она получает сигнал по линии ISO Input 0. 

Следуйте приведенным ниже инструкциям, чтобы настроить получение 

изображения для исследования. 

1 Установите диск с упаковкой фармацевтического продукта на вращаю-

щуюся платформу. Убедитесь, что он твердо закреплен на платформе. 

2 В палитре Inspection Steps перейдите на вкладку Acquire Images. 
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1. Щелкните на Acquire Image (Smart Camera)        . Откроется окно 

свойств. 

2. В поле Step Name введите Acquire Image. 

3. Установите Exposure Time (ms) в значение 0.504. 

4. Установите Gain в значение 170. 

5. Перейдите на вкладку Lighting. Щелкните на Configure Light, чтобы 

открыть соответствующее диалоговое окно. Так как источник света, используе-

мый в этом примере, является предустановленным по умолчанию, вы можете вы-

брать его из списка предустановленных источников света. 

6. Выберите опцию Select Light, затем выберите National Instru-

ments → RL1424-660 (Ring Light, Red) и нажмите OK. RL1424 – это предуста-

новленный источник света. 

7. Убедитесь, что вы выбрали корректный источник света в диалоговом 

окне Confirm Light Selection, и нажмите Yes. 

 

Предупреждение! Выбор неправильного источника света в пунктах 7 и 9 может 

повредить электрические схемы камеры и сам источник света. Убедитесь, что вы 

выбрали правильный источник света. 

 

8. Активируйте флажок Enable Direct Drive Lighting. Это включит све-

тодиодное кольцо света, подключенное к умной камере. 

9. Установите Direct Drive Lighting Mode в режим Strobed. 

10. Установите Desired Current Level (mA) в значение 1000. 

11. Во вкладке Trigger активируйте флажок Triggered Acquisition и 

установите Trigger Polarity в Falling Edge. 

12. Вращайте исследуемый диск и нажмите кнопку Grab         , чтобы 

протестировать конфигурацию. Обратите внимание, что получение изображения 

срабатывает в тот момент, когда этикетка проходит под умной камерой. Изобра-

жение должно быть подобно представленному на рисунке 37. 

15. Нажмите OK, чтобы завершить настройку получения изображения. 
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Рисунок 37 – Полученное изображение с этикеткой 

 

Чтение матрицы данных 

Обратите внимание: каждая этикетка имеет 2D штрихкод в правом верх-

нем углу. 

Следуйте приведенным ниже инструкциям, чтобы прочитать штрихкод.   

 

1. В палитре Inspection Steps перейдите на вкладку Identify Parts. 

2. Щелкните на Read Data Matrix Code           . Откроется окно свойств. 

3. В поле Step Name введите Read Data Matrix. 

4. Нарисуйте ROI вокруг матрицы данных на изображении, как пока-

зано на рисунке 38. 

 

 
 

Рисунок 38 – ROI вокруг матрицы данных на изображении 
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5. Во вкладке Basic активируйте флажок Return Grading Results. 

6. Во вкладке Limits активируйте флажок Minimum Overall Grade и уста-

новите значение B. 

7. Нажмите OK, чтобы добавить шаг в исследование. 

 

Установка статуса исследования 

После того как вы определите, прошла ли деталь проверку на брак, вы должны 

установить переменную Inspection Status соответствующим образом. 

Следуйте приведенным ниже инструкциям, чтобы установить Inspection Status 

на основании результатов, полученных на шаге Read Data Matrix .    

 

1. В палитре Inspection Interface перейдите на вкладку Use Additional 

Tools. 

2. Щелкните на Set Inspection Status          . Откроется окно свойств. 

3. В поле Inspection Status выберите Set to measurement value и установите 

значение Read Data Matrix – Step Status. 

4. Нажмите OK, чтобы добавить шаг в исследование. 

 

Конфигурирование линий ввода-вывода 

При слежении за производственными линиями вам необходимо отбрасывать 

бракованные детали. Это часто делается с помощью отправки сигнала на внеш-

нее устройство, которое выталкивает деталь с линии. 

Следуйте приведенным ниже инструкциям, чтобы настроить слежение таким об-

разом, чтобы умная камера посылала сигнал по линии ISO Output 0, если деталь 

хорошая, и по линии ISO Output 1, если деталь бракованная.   

 

1. В палитре Inspection Interface перейдите на вкладку Communicate. 

2. Щелкните на Generate Pulse          . 

3. В поле Step Name введите Smart Camera I/O Pulse. 

4. В таблице Pulse Settings выберите ISO Out 0. 

5. В поле Pulse Properties выберите Generate Single Pulse. 

6. Установите Delay в значение 0.001 и Width в 50.000, что задаст  ши-

рину импульса равной 50 мс. 

7. В поле Single Pulse Settings выберите опцию Pulse when this step runs 

AND. 

8. Установите Measurement в значение System Variable – Inspection Status is 

Pass. 

9. Выберите ISO Out 1 в таблице Pulse Settings. 

10. В разделе Pulse Properties выберите опцию Generate Single Pulse. 

11. Установите Delay в значение 0.001 и Width – в 50.000. 

12. В поле Single Pulse Settings выберите опцию Pulse when this step runs 

AND. 
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13. Установите Measurement в значение System Variable – Inspec-tion 

Status is Fail. 

14. Таблица Pulse Settings должна выглядеть, как показано на рисунке 39. 

15. Нажмите OK, чтобы добавить шаг в исследование. 

 

 
 

Рисунок 39 – Pulse Settings 

 

Создание пользовательского интерфейса 

Следуйте приведенным ниже инструкциям для настройки пользователь-

ского интерфейса таким образом, чтобы он соответствовал требованиям вашего 

исследования. 

1. Выберите Tools → Inspection Interface Configuration. Это запустит 

диалоговое окно конфигурирования интерфейса исследования. 

2. Во вкладке Inspection Interface выберите Create New Custom Inter-

face form. 

3. Выберите Template Inspection Interface. 

4. Выберите One Image Display Indicator and Pass Fail Indicator. 

5. Нажмите OK, чтобы закрыть диалоговое окно конфигурирования 

интерфейса исследования. 

 

Отображение статуса исследования в пользовательском интерфейсе 

Теперь, когда вы настроили пользовательский интерфейс, вы можете отоб-

ражать статус исследования. 

Следуйте приведенным ниже инструкциям.  

 

1. В окне State Configuration выберите Smart Camera I/O Pulse. 

2. В палитре Inspection Steps перейдите на вкладку           

Use Additional Tools. 

3. Щелкните на Update Inspection UI. Откроется окно свойств. 

4. В таблице Inspection Interface Indicators and Controls выберите # Fail. 

Установите Operation в Set to Measurement. 

5. В поле Measurements выберите Variables → System Variable → # Fail. 

6. Установите другие индикаторы в таблице Inspection Interface Indi-

cators в значения, показанные на рисунке 40. 

7. Нажмите OK, чтобы добавить шаг в исследование.Получение изоб-

ражений для исследования 
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Рисунок 40 – Таблица Inspection Interface Indicators 

 

Сохранение и запуск исследования 

Следуйте приведенным ниже инструкциям, чтобы сохранить исследование 

и запустить его в режиме интерфейса исследования. 

1. Выберите File → Save или нажмите кнопку Save на панели инстру-

ментов. 

2. Введите Label Inspection в поле Inspection Name. 

3. Щелкните на Save         , чтобы сохранить исследование. 

 

Подсказка. Выберите File → Inspection Properties, чтобы добавить крат-

кое описание или комментарии об исследовании. 

 

4. Щелкните на File → Switch to Inspection Interface. На короткое 

время окно закроется и снова откроется в режиме интерфейса исследования. 

5. Нажмите кнопку Start Inspection         и вращайте диск. 

6. Обратите внимание, как моргают светодиоды PASS и FAIL по мере 

вращения деталей под умной камерой. 

 

Заметка. Если вы будете вращать диск слишком быстро, кадры могут пропус-

каться. 

 

7. Нажмите кнопку Stop Inspection          , чтобы остановить иссле-

дование деталей. 

8. Выберите Inspection → Switch to Configuration Interface, чтобы 

вернуться в интерфейс настройки. 
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УПРАЖЕНИЕ 3. Исследование коннектора 

Это упражнение знакомит с диаграммой состояний и веб-сервером, встро-

енными в Vision Builder AI. Необходимо научиться считать количество прово-

дов, входящих в коннектор. Ели провода не хватает, деталь будет отброшена. В 

дополнение к переключению линий ISO обязательно использовать светодиоды 

PASS и FAIL на умной камере. 

 

Создание нового исследования 
Следуйте приведенным ниже инструкциям, чтобы создать новое исследо-

вание. 

1. Выберите Пуск → Программы → National Instruments → Vision 

Builder AI, чтобы запустить Vision Builder AI. Если Vision Builder AI уже запу-

щен, закройте все открытые исследования. 

2. На экране приветствия Vision Builder AI выберите NI Smart Camera в 

списке целей. 

3. Щелкните на New Inspection, чтобы запустить конфигурационный ин-

терфейс. Рисунок 33, размещенный в упражнении 1, показывает основные ком-

поненты конфигурационного интерфейса. 

 

Получение изображений для исследования 

Для текущего упражнения установите диск с коннектором на вращающу-

юся платформу. Убедитесь, что он твердо закреплен на платформе. Умная ка-

мера должна стробировать кольцо света и снимать изображение каждый раз, ко-

гда она получает сигнал по линии ISO Input 0. 

Следуйте приведенным ниже инструкциям, чтобы настроить получение 

изображения для исследования. 

1. Установите диск с коннектором на вращающуюся платформу. Убеди-

тесь, что он твердо закреплен на платформе. 

2. В палитре Inspection Steps перейдите на вкладку Acquire Images. 

3. Щелкните на Acquire Image (Smart Camera)         . Откроется окно 

свойств. 

4. В поле Step Name введите Acquire Image. 

5. Установите Exposure Time (ms) в значение 0.504. 

6. Установите Gain в значение 170. 

7. Перейдите на вкладку Lighting. Щелкните на Configure Light, чтобы от-

крыть соответствующее диалоговое окно. Так как источник света, используемый 

в этом примере, является предустановленным по умолчанию, вы можете выбрать 

его из списка предустановленных источников света. 
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1. Выберите опцию Select Light, затем выберите National Instruments → 

RL1424-660 (Ring Light, Red) и нажмите OK. RL1424 – это предустановленный 

источник света. 

2. В диалоговом окне Confirm Light Selection убедитесь, что вы выбрали 

корректный источник света, и щелкните Yes. 

 

Предупреждение! Выбор неправильного источника света в пунктах 7 и 9 может 

повредить электрические схемы камеры и сам источник света. Убедитесь, что вы 

выбрали правильный источник света. 

 

3. Активируйте флажок Enable Direct Drive Lighting. Это включит све-

тодиодное кольцо света, подключенное к умной камере. 

4. Установите Direct Drive Lighting Mode в режим Strobed. 

5. Установите Desired Current Level (mA) в значение 1000. 

6. Во вкладке Trigger активируйте флажок Triggered Acquisition и уста-

новите Trigger Polarity в Falling Edge. 

7. Вращайте исследуемый диск и нажмите кнопку Grab        , чтобы про-

тестировать конфигурацию. Обратите внимание, что получение изображения 

срабатывает в тот момент, когда коннектор проходит под умной камерой. Изоб-

ражение должно быть подобно представленному на рисунке 41. 

8. Нажмите OK, чтобы завершить настройку получения изображения. 

 

 

  
 

Рисунок 41 – Коннектор 
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Подсчет проводов 

Если количество проводов, входящих в коннектор, не равно пяти, деталь 

считается бракованной. 

Следуйте приведенным ниже инструкциям, чтобы подсчитать количество 

проводов, входящих в коннектор, с использованием инструмента простого по-

иска углов.   

 

1. В палитре Inspection Steps перейдите на вкладку Locate Features. 

2. Щелкните на Find Edges  . Откроется окно свойств. 

3. В поле Step Name введите Count Wires. 

4. Нарисуйте горизонтальную линию ROI прямо под коннектором, в 

месте, где провода соединяются с ним, как показано на рисунке 42. 

 

 
 

Рисунок 42 – Линия ROI 

 

5. Во вкладке Settings установите Edge Polarity в значение Dark to 

Bright Only. Ваше изображение должно быть похоже на рисунок 42. 

6. Во вкладке Limits активируйте флажки Minimum Number of Edges 

и Maximum Number of Edges и установите число 5 в качестве обоих значений. 

7. Нажмите OK, чтобы добавить шаг в исследование. 

 

Установка статуса исследования 

После того как вы определите, прошла ли деталь проверку на брак, вы 

должны установить переменную Inspection Status соответствующим образом. 

Следуйте приведенным ниже инструкциям, чтобы установить Inspection 

Status на основании результатов, полученных на шаге Find Edges.  

1. В палитре Inspection Interface перейдите на вкладку Use Additional 

Tools. 
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2. Щелкните на Set Inspection Status         . Откроется окно свойств. 

3. В поле Inspection Status выберите Set to measurement value и 

установите значение Count Wires – Step Status. 

4. Нажмите OK, чтобы добавить шаг в исследование. 

 

Конфигурирование линий ввода-вывода 

При слежении за производственными линиями вам необходимо отбрасы-

вать бракованные детали. Это часто делается с помощью отправки сигнала на 

внешнее устройство, которое выталкивает деталь с линии. 

Следуйте приведенным ниже инструкциям, чтобы настроить слежение та-

ким образом, чтобы умная камера посылала сигнал по линии ISO Output 0, если 

деталь хорошая, и по линии ISO Output 1, если деталь бракованная. 

1. В палитре Inspection Interface перейдите на вкладку Communicate. 

2. Щелкните на Generate Pulse          . 

3. В поле Step Name введите Smart Camera I/O Pulse. 

4. В таблице Pulse Settings выберите ISO Out 0. 

5. В поле Pulse Properties выберите Generate Single Pulse. 

6. Установите Delay в значение 0.001 и Width – в 50.000, что задаст 

ширину импульса равной 50 мс. 

7. В поле Single Pulse Settings выберите опцию Pulse when this step 

runs AND. 
8. Установите Measurement в значение System Variable – Inspection 

Status is Pass. 
9. Выберите ISO Out 1 в таблице Pulse Settings. 

10. В разделе Pulse Properties выберите опцию Generate Single Pulse. 

11. Установите Delay в значение 0.001 и Width – в 50.000. 

12. В поле Single Pulse Settings выберите опцию Pulse when this step 

runs AND. 
13. Установите Measurement в значение System Variable – Inspection 

Status is Fail. 

14. Таблица Pulse Settings должна выглядеть, как показано на рисунке 43. 

15.  Нажмите OK, чтобы добавить шаг в исследование. 

 

 
 

Рисунок 43 – Таблица Pulse Settings 
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Создание пользовательского индикатора 
Следуйте приведенным ниже инструкциям, чтобы отобразить булев инди-

катор, показывающий, является ли деталь бракованной, на изображении. 

1. В палитре Inspection Steps перейдите на вкладку Use Additional Tools. 

2. Щелкните на Custom Overlay         . Откроется окно свойств. 

3. В поле Step Name введите Display Result. 

4. На вкладке Custom Overlay щелкните на Indicator Tool         и нарисуйте 

небольшой прямоугольник над коннектором. 

5. Установите Value в значение System Variable – Inspection Status. 

6. В поле True Text введите PASS. 

7. В поле False Text введите FAIL. 

8. Изображение на экране должно быть похоже на рисунок 44. 

9. Нажмите OK, чтобы добавить шаг в исследование. 

 

 
 

Рисунок 44 – Пример получаемого изображения 

 

 

Создание пользовательского интерфейса 
Следуйте приведенным ниже инструкциям для настройки пользователь-

ского интерфейса таким образом, чтобы он соответствовал требованиям вашего 

исследования. 

1. Выберите Tools → Inspection Interface Configuration. Это запустит 

диалоговое окно конфигурирования интерфейса исследования. 

2. Во вкладке Inspection Interface выберите Create New Custom Interface 

form. 

3. Выберите Template Inspection Interface. 

4. Выберите Two Image Display Indicators. 
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5. Нажмите OK, чтобы закрыть диалоговое окно конфигурирования интер-

фейса исследования. 

 

Обновление изображений PASS/FAIL 

Так как интерфейс исследования содержит две области для вывода изобра-

жений, вы можете выводить разные изображения в каждую область. 

Следуйте приведенным ниже инструкциям, чтобы выводить хорошие де-

тали в левую область окна программы и бракованные – в правую.   

 

1. Щелкните на Toggle Main Window View            на панели инструментов, 

чтобы отобразить диаграмму состояний. Рисунок 45 показывает, как выглядит 

диаграмма состояний по умолчанию. 

 

 
 

Рисунок 45 – Диаграмма состояний 

 

2. Щелкните правой кнопкой мыши на свободной области диаграммы со-

стояний и выберите Create New State, чтобы добавить новое состояние в иссле-

дование. 

3. В поле State Name введите Passed Part. 

4. Нажмите OK. 

5. Создайте еще одно состояние и назовите его Failed Part (необхо-

димо повторить пункты 2–4). 

6. Вы можете перемещать любые элементы диаграммы состояний по сво-

ему усмотрению. Чтобы изменить направление перехода (стрелки), вы можете 

направить наконечник стрелки в другое состояние. Перестройте свою диаграмму 

состояний, чтобы она стала похожа на рисунок 46. 
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Рисунок 46 – Измененная диаграмма состояний 

 

7. Щелкните правой кнопкой мыши на состоянии Inspect и выберите  

Create New Transition. 

8. Щелкните на состоянии Failed Part, чтобы создать новый переход 

между состояниями Inspect и Failed Part, как показано на рисунке 47. 

 

 
 

Рисунок 47 – Добавление Transition в диаграмме состояний 

 

9. Дважды щелкните на Transition 1, чтобы запустить диалоговое окно 

Edit Transition, которое используется для конфигурирования переходов между 

состояниями. 
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10. В поле Transition Name введите Failed. 

11. В диалоговом окне Edit Transition настройте параметры таким образом, 

чтобы переход осуществлялся, когда переменная установлена в состояние Sys-

tem Variable – Inspection Status is Fail. 

12. Нажмите OK, чтобы закрыть диалоговое окно Edit Transition. 

13. Щелкните на Passed Part на диаграмме состояний. Любые шаги, кото-

рые вы добавите, будут относиться к состоянию Passed Part. 

14. В палитре Inspection Steps перейдите на вкладку Use Additional Tools. 

15. Щелкните на Update Inspection UI           .   

16. В таблице Inspection Interface Indicators and Controls выберите Image 1. 

17. В поле Operation выберите Set to Measurement. 

18. В поле Images выберите Current Image. 

19. Нажмите OK, чтобы добавить шаг в исследование. 

20. Щелкните на Failed Part на диаграмме состояний. 

21. В палитре Inspection Steps перейдите на вкладку Use Additional Tools. 

22. Щелкните на Update Inspection UI           . 

23. В таблице Inspection Interface Indicators and Controls выберите Image 2. 

24. В поле Operation выберите Set to Measurement. 

25. В поле Images выберите Current Image. 

26. Нажмите OK, чтобы добавить шаг в исследование. 

 

Сохранение и запуск исследования 
Следуйте приведенным ниже инструкциям, чтобы сохранить исследование 

и запустить его в режиме интерфейса исследования. 

1. Выберите File → Save или нажмите кнопку Save на панели инструментов. 

2. Введите Connector Inspection в поле Inspection Name. 

3. Щелкните на Save         , чтобы сохранить исследование. 

 

Подсказка. Выберите File → Inspection Properties, чтобы добавить краткое опи-

сание или комментарии об исследовании. 

 

4. Щелкните на File → Switch to Inspection Interface. На короткое время 

окно закроется и снова откроется в режиме интерфейса исследования. 

5. Нажмите кнопку Start Inspection          и вращайте диск. 

6. Обратите внимание, как моргают светодиоды для линий ISO Output 0 и 

ISO Output 1 по мере того, как коннектор вращается под умной камерой. Левое 

изображение обновляется всякий раз, когда камера фиксирует хороший коннек-

тор, правое – когда бракованный. 
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Заметка. Если вы будете вращать диск слишком быстро, кадры могут пропус-

каться. 

 

7. Нажмите кнопку Stop Inspection         , чтобы остановить исследование 

коннекторов. 

8. Выберите Inspection → Switch to Configuration Interface, чтобы вер-

нуться в интерфейс настройки. 

 

Подключение с помощью веб-браузера 

Умная камера может хостить веб-сервер, который используется Vision 

Builder AI для предоставления удаленного доступа к пользовательскому интер-

фейсу исследования с помощью браузера. 

Следуйте приведенным ниже инструкциям, чтобы настроить сервер и по-

лучить доступ к исследованию из браузера. 

1. Выберите Target → Target Options на панели инструментов Vision 

Builder AI, чтобы запустить диалоговое окно Remote Target Options. 

2. В поле Category выберите Web Server. Информация о сервере по-

явится в правой части диалогового окна. 

3. Активируйте флажок Enable Web Server. 

4. Щелкните на Add. 

5. В поле Browser Address введите *. 

6. Выберите опцию Allow Viewing. Теперь любой компьютер может про-

сматривать исследование на умной камере. 

7. Нажмите OK, чтобы закрыть диалоговое окно Remote Target Options. 

8. Выберите File → Switch to Inspection interface, чтобы закрыть интер-

фейс конфигурирования и запустить интерфейс исследования. 

9. Щелкните на Start Inspection и вращайте диск, чтобы начать исследование. 

10. Когда исследование запущено, нажмите Inspection → Close на панели 

инструментов. Появится диалоговое окно Stop Inspection, как показано на ри-

сунке 48. 

 

 
 

Рисунок 48 – Диалоговое окно 

 

11. Выберите No, Close Only. Исследование продолжится, несмотря на 

то, что Vision Builder AI будет закрыт. 
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Получение доступа к исследованию 

Если на умной камере запущено исследование и работает правильно скон-

фигурированный сервер, вы можете получить доступ к исследованию из брау-

зера. 

Следуйте приведенным ниже инструкциям, чтобы получить доступ к ис-

следованию из браузера. 

1. Запустите браузер. 

В строке адреса введите http://<IP-адрес умной камеры> и 

нажмите клавишу Enter. Исследование должно появиться в окне вашего брау-

зера, как показано на рисунке 49. 

 

 
 

Рисунок 49 – Доступ через браузер 

 

 

4.2 ЛАБОРАТОРНАЯ РАБОТА №2 

Визуальный контроль объектов с элементами принятия                          

решений 

 

Цель работы: разработать приложение для решения задач визуального 

контроля объектов с элементами принятия решений. 
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Исходные данные: объекты для анализа (пример – рисунок 50). 

 

 
 

Рисунок 50 – Пример объекта для анализа 

 

Ход выполнения работы: 

1. Выбрать методы и алгоритмы решения задачи. 

2. Программная реализация. 

3. Тестирование. 

4. Подготовка отчета (титульный лист, цель работы, краткое описание мето-

дов и алгоритмов, особенности программной реализации, результаты тестирова-

ния и выводы). 

 

Контрольные вопросы:  

1. Назвать основные элементы технического зрения. 

2. Перечислить основные требования к алгоритмам машинного обучения. 

3. Какие этапы включает в себя разработка систем анализа и обработки циф-

ровых изображений? 

4. Описать порядок выполнения расчета горизонтального и вертикального 

полей зрения (FOV). 

5. Перечислить общие шаги проектирования приложения для обработки 

изображений в системе NI. 

6. Объяснить принципы определения цифрового изображения, назвать его 

основные свойства. 

7. Что такое цветовые модели? 
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4.3  ЛАБОРАТОРНАЯ РАБОТА №3  

Распознавание образов. Классификация объектов 

 

Цель работы: разработать приложение для решения задач распознавания 

образов и классификации объектов. 

 

Исходные данные: объекты для анализа (пример – рисунок 51). 
 

  
 

Рисунок 51 – Пример распознавания объектов 
 

Ход выполнения работы: 

1. Определить подходящий набор методов и алгоритмов для выполнения за-

дания. 

2. Выполнить программную реализацию. 

3. Провести тестирование полученных результатов. 

4. Проанализировать результаты и подготовить отчет (содержание анало-

гично оформлению отчета в лабораторной работе №2). 
 

Контрольные вопросы:  

1. Что такое альфа-композиция? 

2. Что такое «палитры»? Назвать основные характеристики. 

3. Какие основные признаки можно определить по гистограммам? 

4. Объяснить порядок расчета линейной и куммулятивной гистограмм. 

5. Объяснить порядок распознавания образов по шаблону. 

6. Назвать ограничения по применению распознавания по шаблону. 

7. Что такое нормированная взаимная корреляция? 
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4.4 ЛАБОРАТОРНАЯ РАБОТА №4  

 Решение некоторых прикладных задач 

 

Цель работы: разработать приложение для решения прикладных задач 

компьютерного зрения. 

 

Исходные данные: объекты для анализа (пример – рисунок 52). 

 

 
 

Рисунок 52 – Пример распознавания штрихкода 

 

Ход выполнения работы: 

1. Исследовать методы и алгоритмы обработки Barcode и QR-кодов. 

2. Реализовать программными средствами СТЗ NI. 

3. Выполнить функциональное тестирование разработанного решения. 

4. Выполнить анализ полученных результатов и оформить в виде отчета 

(титульный лист, цель работы, краткое описание методов и алгоритмов, особен-

ности программной реализации, результаты тестирования и выводы). 

 

Контрольные вопросы:  

1. Каковы возможности применения градиентного метода в распознавании 

образов? 

2. Объяснить порядок вычисления нормированной взаимнокорреляцион-

ной функции. 

3. Назвать основные поля и характеристики QR-кода. 

4. Описать особенности DataMatrix-кода. 

5. Объяснить алгоритм среднего сдвига для отслеживания объекта. 

6. Объяснить алгоритм среднего сдвига на основе ЕМ-алгоритма. 
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